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Welcome

Migraph Inc. is pleased to present you with Easy—DrawR, the
object-oriented drawing program that makes it casy for anyone to
create professional-looking line drawings, technical illustrations,
and reports with a personal computer.

Easy-Draw is fast, flexible, and just plain fun to use. With it you
can create complex illustrations, floor plans, landscape designs,
etc. By using both the text and graphics features, you have a sim-
ple desktop publishing system that can be used to create newslet-
ters, brochures, presentation aides, forms, ads, flyers, and much
more. We know that as you grow familiar with Easy-Draw, you'll
discover many more uses.

What's in This Book

This book is divided into four major parts: an introductory section
shows you the basics of drawing with Easy-Draw; a section de-
scribing advanced techniques; a section of examples that will pro-
vide you with some ideas of ways to use Easy-Draw; and a sum-
mary section to answer your questions about Easy-Draw features
and commands. This book is not meant to be read cover-to-cover,
but to be picked up as a need for it arises. You'll have much more
fun exploring the product on your own once you've become fa-
miliar with the basic techniques, which are described in the first
section.

For Look in

Introduction to the basic First section: First Drawings

techniques

Advanced techniques Second section: Master
Drawings

Examples and more practice Third section: Sample
Drawings

Reference and answers to Fourth section: Summarics

your questions
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Overview of Easy-Draw

Easy-Draw presents a drawing surface very much like a drafting
table with quadrant (or graph) paper attached to it. The squares
of the quadrant paper line up with markings on horizontal and
vertical rulers. For this basic work surface, Easy-Draw provides
drawing tools for the geometric shapes: squarcs, rectangles, cir-
cles, wedges, ellipses, arcs, straight lines, and free hand lines.
Easy-Draw also has a lettering tool, called text, for adding titles,
labels, notes, and legends to drawings.

You can use Easy-Draw to create a large variety of drawings be-
cause the basic shapes can become your tools to form the parts of
a complex drawing. Each tool draws an object, such as a square
or circle. By combining the objects, you can build up a drawing
that depicts just about anything: a floor plan, an organization
chart, a company logo, even a business form.

What's the Difference?

How does Easy-Draw differ from a paint program? The major
difference is structure. As a result of structure, each object is an
entity unto itself. In painting programs, each thing you paint
obliterates everything else it covers, the way wall paint sticks to
the previous layer of paint, dirt, and graffiti. In Easy-Draw, each
object has its own layer. It's as if a drawing were a composite of
multiple sheets of plastic, each with a single object on it. So even
though one object covers another, it only blocks rather than oblit-
erates. In addition, objects can be made transparent so that the
"hidden" objects show through. Because each object stands alone
as a whole piece, you cannot erase part of an object as you might
in a painting program.

While some painting programs offer a grid as an option, the grid
is an important part of the structure of a drawing program. The
grid provides precise positioning, precise alignment, and measur-
able sizes and spacing. Moreover, because the grid is a central
part of the structure, its markings can be adjusted as needed for
finer or coarser measurements. The grid provides the basis for
magnifying parts of a drawing to any level, not just one or two
preset levels such as bits or whole page.
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What's the Process?

The process of creating a complete drawing involves the repeated
drawing of objects that you combine to form a whole picture. The
Easy-Draw drawing process involves the following steps:

* Choose a drawing tool from the Pop-Up menu.

The Pop-Up menu appears wherever the mouse pointer is lo-
cated so that you don't have to fetch a drawing tool. The right
mouse button brings up the Pop-Up menu.

* Draw the object using the left mouse button.

Position the object by moving the mouse with both mouse
buttons up.

If necessary before pasting down the object, adjust the size
and direction using the left mouse button again.

* Paste down the object with the right mouse button.

After drawing an object, you can add or change color, pattern, or
line width and style to suit your purposes. For text, you can
choose color, appearance, size, and style (font).

Once the process is complete, you can save the drawing perma-
nently on disk for later use, for printing, or for revisions. Easy-
Draw has commands for revising (editing) drawings, for arranging
the objects within a drawing, and for changing the magnification
of the drawing (zooming) so you can see selected portions in
detail.

To further support your real life tasks, Easy-Draw also gives you
several choices for the size of paper and the direction your draw-
ing will be printed on it (up-and-down or lengthwise).

Some Terms

The following terms and their definitions will help you identify the
various items and techniques within Easy-Draw.

Choose To indicate a menu, command, choice in a
dialog box, or a drawing tool you want to use
by moving the mouse pointer onto your
choice then clicking the left mouse button.

Click Press and release a mouse button.

Drawing A collection of objects arranged to form a
picture of something.
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Drawing Tools

Shape
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The drawing tools are the basic shapes on the
Pop-Up menu, which appears at the position
of the mouse pointer when you click the right
mouse button. Move the mouse to highlight
the tool you want to use, then click the left
mouse button. The Pop-Up menu will be re-
placed by the cross hair pointer, used for
drawing.

The following table shows the Pop-Up menu
and summarizes what happens when you use
the drawing tools.

Tool Name and Summary

OO0

E S AEE [

Box: a rubber band box grows in the direction
you move the mouse.

Rounded Box: drawn the same as Box.

Circle: small cross marks center; circle grows
outward evenly from center.

Ellipse: small cross marks center; ellipse
stretches outward lopsidedly from center.

Circular Wedge: small cross marks center; 90
degree wedge grows outward evenly from
center; arrow keys adjust angle for wedges
more than or less than 90 degrees.

Elliptical Wedge: small cross marks center;
wedge stretches outward lopsidedly from
center; arrow keys adjust angle for wedges
more than or less than 90 degrees.

Circular arc: drawn the same as circular
wedge.

Elliptical arc: drawn the same as elliptical
wedge.

Straight line: line grows in direction you
move mouse; can swing line around 360 de-
grees while growing.

Polyline: drawn the same as straight line, but
you can draw multiple straight lines with each
click of right mouse button.

Free hand sketching: continuous, curving line
grows in directions you move the mouse.
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Te Text: text box drawn same as box; click right
Il  mouse button; type text; click right mouse
button

The advantage of the Pop-Up menu is that it is always conve-
niently placed where you are working. You do not have to move
across the drawing surface to the edge or to a drop down menu
just to change tools. You save time and effort and do not have to
break your concentration on your work to perform this simple
mechanical step.

Object Anything you draw as one piece of a drawing.
Squares and circles are obvious objects.
Lines, polylines, arcs, and even text are also
objects. Any part of a drawing which, when
selected, has an object box around it.

Object Box A box that appears around objects when they
are selected. The object box has either 4 or 8
sizing markers on it. The primary purpose of
the object box is to change the size or shape
of the object inside it.

Mouse Buttons The Atari ST mouse has two buttons. Only
the left mouse button is used on the GEM
desktop, but in Easy-Draw, you will use both
buttons. The following table may help you
remember the basic distinction between the
uses of the two buttons:

Left button Right button

Draw objects Bring up Pop-Up menu
Size objects Paste down new object
Select objects Escape from Pop-Up menu
Move existing selected Escape from drawing new
object object when pressed with

left button down, then both
released together
Choose commands Escape from drawing to se-
lecting (double click)
Choose dialog box choices

While creating an object, moving the mouse with both buttons up
moves the object.
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Pointer The indicator on the screen that shows where
you are on the drawing. Easy-Draw has the
following pointer shapes:

Cross hair (drawing) pointer
Finger (selection) pointer
Open Hand (move) pointer

» % +

Arrow (choice) pointer for menus, com-
mands, dialog boxes, and drawing tools

Polyline A drawing tool for drawing any number of
connected straight lines. These may form a
completed, closed object or may simply be a
group of connected straight lines that form an
open object; for example, a zig-zag line.

Rubber Band Box A box that appears on the drawing surface
when you select an area or when you are
changing the size of an object.

Select To indicate an object or area of the drawing
surface that you want to work on. Selected
objects show their object boxes.

Sizing Marker The little squares on an object box you point
to with the mouse and move to change the
size of an object.

How's My Memory?

Because a drawing can have multiple layers of objects, a drawing
can require more memory and disk space than a painting, which
has a fixed maximum size. While you can create a very complex
drawing with 500-600 objects, you should be aware of the limits
and requirements of memory Easy-Draw (and any drawing pro-
gram) has. Easy-Draw limits are based on the amount of memory
your computer has. The following table shows the approximate
limits and requirements.

Amount of memory Approx Number of objects

520ST (512K) 4000
1040ST (1M) 12000
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Setting Up Your Easy-Draw Master Disk

You must have yoyr Easy-Draw Master disk in drive A when you
turn on your Atari ST. For maximum use of your computer's
memory for Easy-Draw, you should limit the number of desktop
accessories in memory.

Important: You can use desk accessories with Easy-Draw , but
be aware that each desk accessory takes up memory that can be
used for drawings. If you have very large amount of memory
taken by one or more desk accessories, Easy-Draw may not load
into 512K. We recommend that you load only the desk acces-
sories that you absolutely need.

Copies of Easy-Draw and Disk Drives

You can make one copy of Easy-Draw on a floppy disk or hard
disk, as stated in the license agreement. See Chapter 6,
"Managing Disks, Files, and Folders," in your Atari 520ST
Computer Owner's Manual for directions for copying floppy disks.

Hard disk owners who would like to install Easy-Draw and all its
support files on their hard rive should refer to Appendix A.

Storing Drawings

You are advised against saving your drawings on your original
Easy-Draw Drawing disk. Instead, save your drawings on a copy
of the Easy-Draw Drawing disk. For those of you who need in-
formation concerning creating new drawing disks, please see
Appendix B.

Printer Requirements

The printqhxou use with Easy-Draw must be compatible with
Epson FX" ™ graphics printers.

Note: Other output devices will be supported with optional soft-
ware drivers from Migraph. An example at the time of this print-
ing is HP LaserJet Plus laser printer.

For information regarding current drivers available, please call
Migraph at 206-838-4677.



14

Migraph Easy-Draw



First Drawings

This section contains a short walk-through lesson to make you
familiar with the basic techniques for using Easy-Draw. When
you're done, you should know enough about Easy-Draw to ex-

plore the program freely and easily.

This section covers the following topics:

*

*

*

Starting Easy-Draw
How to draw objects and move them

How to fill in objects with a pattern, change the color, and
change the line width

How to select objects and change their size
How to place text in a drawing

How to store a drawing to save it for later use
How to print a drawing

How to quit Easy-Draw

Starting Easy-Draw

To start Easy-Draw from a floppy disk, follow these directions:

(1]
(2]
13

[4]

Insert the Easy-Draw Master Disk in drive A.
Turn on your Atari ST.

When a window appears with a list of the files on your Easy-
Draw disk, move the mouse until the arrow rests on the
name EASYDRAW.PRG.

This is called pointing.

Double click (press and release very rapidly twice in succes-
sion) the left mouse button.

Easy-Draw will start, and you will see the following screen:
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Look Around First

An easy way to become quickly familiar with any program at the
beginning is to look at all the menus. If you like, try this now.
Move the mouse pointer (the finger on the screen) onto each
menu name in turn (the pointer becomes an arrow). Pause at
cach name to let the menu drop down. Look at the names on the
menu; these names are the Easy-Draw commands, which you will
use to adjust your objects and drawings. All the commands are
explained in the chapter "Menu Commands" for later reference.

You'll see that some of the commands are gray and some are

black. Black commands are available for use; gray commands are

not available right now because they are not applicable. Gray

commands require some preliminary action before they are .
useful.
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Some menus also contain gray names in the middle of gray lines.
These names are dividers that separate commands on a menu
into groups. For example, on the Page menu, ---Grid--- ap-
plies to the three commands below it: (Grid) SPACING..., (Grid)
DISPLAY ON, and (Grid) SNAP ON.

When you've seen all the menus and are ready to learn to use
Easy-Draw, move the mouse pointer onto the drawing surface
and click the left mouse button. This is how you cancel a menu.
Now, go to the next section.

Drawing a Box

To draw any object, you will first bring up the Pop-Up menu,
you'll choose a drawing tool, then you'll draw the object.

To draw a box, following these directions:
[1] Anywhere on the drawing surface, click (press and release)

the right mouse button to bring up the Pop-Up menu, which
looks like this:

~ /|2 elOLE
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Question: What if I change my mind after I've brought up the
Pop-Up menu? Then, click the right mouse button again to make
the Pop-Up menu disappear. If you want to, try it now. Then,
press the right button to bring up the Pop-Up menu again.

[2] Point to the box in the upper left corner of the menu, then
click the left mouse button.

This step chooses the drawing tool you will use. The mouse
pointer becomes a hollow cross, called the cross hair
pointer. When you see the cross hair pointer, Easy-Draw is
ready to draw objects.

[3] Point to the place on the drawing surface where you want to
start the box.

[4] Hold down the left mouse button and move the mouse to
draw the box to the size you want it.

[5] When the box is the size you want it, release the left button.

Moving the Box

Question: Did you jiggle the mouse after you finished drawing
the box? Did the box move?

When you've finished drawing an object, it is not yet pasted down
on the drawing surface. If the box is not the size or shape you
want it, hold down the left mouse button again and move the
mouse to adjust the size and shape. Until you paste it down, you
can move the box anywhere on the drawing surface by moving the
mouse with no buttons pressed.

* To move the box, move the mouse. Try it. Put the box where
you want it.

Note that this method of moving the object only works before
you paste it down. Later you'll learn how to move an object
that has been pasted down.

* To paste down the box, or any other object after you've drawn
it, click (press and release) the right mouse button. Do this
now.

The box appears with an extra box around it that has little squares
attached to it, which means the object is selected. To change an
object, it must be selected. The extra box is called the object box;
the little squares are called sizing markers. You'll learn more
about these a little later.
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Filling the Box with a Pattern

To fill an object with a pattern, you will choose Styles from the
Pattern menu, then choose a pattern from the dialog box.

To fill the box with a pattern, follow these directions:

[1] Point to the Pattern menu.

The menu drops down and shows four commands: STYLES,
TRANSPARENT, SHADOW, and USER PATTERN.

[2] Point to STYLES and click the left button.

This is called choosing a command. When you choose the
PATTERN STYLES command, a dialog box appears that looks
like this:

v

[3] Point to the pattern you'd like to fill the box with (choose
any pattern), then click the left mouse button.

Easy-Draw will fill the box with the pattern you chose.

Changing the Pattern

After seeing a pattern on the screen (or printed out, perhaps),
you may decide that you'd like to use a different pattern.

To change the pattern in the box, follow these directions:

[1] Choose STYLES from the Pattern menu by pointing first to
Pattern, then to STYLES, then clicking the left mouse button.

[2] Choose the new pattern by pointing to the one you want,

then clicking the left mouse button to give the box the new
pattern.
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Changing the Color

Easy-Draw and your Atari ST can display your objects in four
colors. To choose a color, you will choose the Color menu, then ‘
choose the color you want.

To choose a color, follow these directions:

[1] Point to the Color menu.

The Color menu appears, with a checkmark beside the cur-
rent color.

[2] Point to the color you want, then click the left mouse button.

Easy-Draw changes the selected object and the pattern to
the new color.

See the chapter entitled "Setting Colors" when you want to
learn more about color control in Easy-Draw.

Changing the Width of the Line

If you decide that the line of the box is too narrow (or too fat if '
you drew a fat line), you can change the width of the line by using
the Line menu.

To change the width of a line, follow these directions:

[1] Point to the Line menu.

The Line menu appears with checkmarks beside the current
choices for line width and style, and for line end styles
(arrowheads) for open lines.

[2] Choose the line width or style you want by pointing to the
example in the menu.

[3] Click the left mouse button to change the line width to the
new width.

Note: When you change the line width or style, Easy-Draw also
uses your choice for the lines of all the objects, except text, that
you draw subsequently.
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Drawing Another Box

If you want to add another box to your drawing, you can do so by
simply holding down the left mouse button and drawing it. You
don't have to choose the drawing tool again as long as you are
drawing the same kind of object.

To draw another box, follow these directions:

[1] Point anywhere on the drawing surface.

[2] Hold down the left mouse button.

[3] Draw a box, then release the left mouse button.

[4] Move the box where you want it with both mouse buttons
up.

[5] Click the right mouse button to paste down the new box.

The new box becomes the selected object; it has an object
box around it. The new box has the pattern, color, and line
width you last chose.

You can work on this box to change the pattern, color, and
line width, just as you did for the first box.

This technique for drawing another box works for all the objects
you draw. As long as the pointer is a cross hair, you can continue
to draw the type of object you last chose from the Pop-Up menu.

Changing the Size of the Box

Once you've drawn and pasted down an object, you may decide
that it's not the right size for your needs. Easy-Draw provides
tools for easily changing the size of an object.

Before you can work on an object, it must have an object box
around it. An object box is a box around the object with little
squares on it. When an object has an object box around it, it is
selected, which means whatever you do next will affect that ob-
ject, but nothing else at the moment.
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To change the size of the first box you drew, follow these
directions:

(1]

(2]

3]

Change to Point Mode instead of draw mode.

Switch from drawing (cross hair pointer) to selecting (finger
pointer) by clicking the left mouse button while the pointer
is over the desktop.

(There are several other ways to select point mode, which
are described in the "Hints" section of this manual.)

Select the first box you drew.

When you see the finger pointer, point inside the first box
and click the left mouse button.

Decide how you'd like to change the size of the box, then
choose the appropriate sizing marker and move it.

To choose a sizing marker, place the tip of the finger directly
in the middle of the sizing marker. To change the size of the
box, hold down the left mouse button, then move the mouse,
either to expand or shrink the box.

Feel free to try all the ways that you can change the size of
the box. Trying all the ways will give you a good feel for how
much control you have in Easy-Draw.
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Writing Text

Placing text is similar to placing an object or line on a drawing,.
Text is one of the choices on the Pop-Up menu.

To write a title, follow these directions:

(1
(2]

3]
[4]

[5]

[6]

(7]

[8]

%]

Bring up the Pop-Up menu by clicking the right mouse
button.

Choose Text from the Pop-Up menu by pointing to the Text
drawing tool then clicking the left mouse button.

Point to the spot where you want the text to begin.

Hold down the left button and draw a box, which will hold
the text.

Release the left button when the box is the size you want.

Remember to make the box large enough to hold all your
text. You can change its size later at any time, but this will
help you while you are typing in the text.

If necessary, move the text box where you want it by simply
moving the mouse while both mouse buttons are up.

Click the right button to paste down the text box.

When you paste the text box down, the pointer becomes a
vertical line positioned in the upper left corner of the text
box. The text box has a white background temporarily, and
sizing markers to change the size of the text box while you
are creating the title.

Type a title, such as:

This is an example of
justified text which fills the
inside of the text box.

Be sure to press Return key at the end.

Notice that the text wraps around at the end of the line. Use
the arrow keys on the keyboard to move the vertical line for
editing the title. Use the Backspace key to erase to the left;
use the Delete key to erase to the right. You can also press
the Return key in the text box to start a new paragraph. See
the description of the Edit Text command in the chapter cn-
titled "Menu Commands" for further details of editing text.
When you have finished typing the text, click the right mouse
button to paste down the text itself.

The text box will now have a transparent background. For an

illustration of this, see the figure for "Inserting Text" in the
chapter entitled "Techniques."
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Changing the Size of the Letters

Easy-Draw lets you choose how large you want the letters to be.
You can also choose the appearance of the letters: bold, light,
italic, outlined, or underlined. To change the size or appearance
of text, you will choose settings on the Text menu.

To change the size of the letters in the title, follow these
directions:

[1] Point to the Text menu.

[2] Point to the size you want under the --Height-- label,
then click the left button to change the size of the text.

Question: What do the numbers mean? The numbers in the
dropdown represent point sizes for letters. Perhaps the easiest
way to deal with point sizes is to choose a size and look at the re-
sult. Your eye is the best judge of the appropriate point size. Re-
fer to the description of the Height command in the chapter enti-
tled "Menu Commands" for more details about point sizes.

Question: When I chose a larger point size, some of my text dis-
appeared. What happened to it? Easy-Draw shows as much text
as will fit in the text box, which is why you should be sure the text
box is large enough when you create it. When you increase the
point size, all the text may not fit in the box. Easy-Draw clips off
the excess, but the text is not lost. If the text does not fit in the
text box, you have a choice: either reduce the point size or expand
the text box.

* To expand the text box, use the same steps you used earlier to
change the size of the box you drew. The text box can be hori-
zontally or vertically oriented.

* To change the point size, choose a new point size from the
Text menu.

* Probably the most used text option is Justify. This option right
justifies your text so it expands to fill the width of your text
box instead of a ragged side. (Remember to press Return at
the end of multiple line text labels, or the last line expands to

the right.)

If you want to experiment with the appearance of the characters,
you can choose one or more of the appearance settings in the top
part of the Text menu.
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Saving the Drawing

If you want, you can storc your drawings for usc or reference later
on. You can storc partially completed drawings, then come back
later to work on them some more. Also, before you can print, you
neced to store your drawing.

Note: Single disk drive owners must place their drawing disk in
drive A before saving drawings. Dual drive owners should alrcady
have their drawing disk in drive B.

To save a drawing, follow these directions:

(1
2]

13

Choose SAVE AS from the File menu.

The File Sclector box appears.

Type a name for your drawing, such as:
Boxes

Easy-Draw uscs this name to identify the drawing for you so
that you get it back later. The name can have up to cight
letters and numbers in any order.

Point to the box with OK insidc it, then click the left mouse
button.

Easy-Draw saves your drawing on the disk in a file named
BOXES.GEM.

Note: If you have saved a drawing at lcast once before, you can
choose File Save (or press F1 key) to quickly save your changes (o
a drawing without having to typc the name again.

Note: The default drive to save your drawing for cach window is
the drive that Easy-Draw was started from. To change the disk
drive, edit the linc under "Dircctory” in the File Sclector box. For
cxample, to save to drive B, Backspace over A:\* GEM, type

B:\* GEM, movc the mousc pointer to the list of names, and click
the left mouse button.
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Printing the Drawing

If you want to print your drawing, be sure your printer is ready:
turned on and online, paper inserted and aligned, ribbon ready.
Also, remember to have your drawing disk inserted first, as de-
scribed under "Saving the Drawing."

To print a drawing, follow these directions:

(1]
(2]
B3]

(4]
[5]

[6]

[71

Choose OUTPUT from the File menu.

Choose ADD NAME from the Edit menu.

Point to the name of your drawing in the File Selector box,
then click the left mouse button.

Choose START OUTPUT from the File menu.

Point to PRINTER in the dialog box, then click the left
mouse button.

Point to OK, then click the left mouse button to start
printing.

Important: If you have only one disk drive, you must insert
you Easy-Draw Master Disk now, before quitting from
Output.

When printing is finished, choose QUIT from the File menu
to quit printing and to return to Easy-Draw.

Note: The printer output capability of Easy-Draw produces pic-
tures at a much higher resolution than shown on the screen.
However, this output process does take a few minutes to print.
For a quick copy of your drawing (at any time), there is an alter-
nate method to follow. With your printer ready, you can do a
screen hard-copy by pressing the Alternate and Help keys at the
same time. This will automatically give you a quick print of the
entire screen. You can also toggle the screen hard-copy off by
pressing the same keys again.
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Quitting Easy-Draw

. When you are done working on drawings and want to shut off
Easy-Draw, you will choose Quit from the File menu.

To quit Easy-Draw, follow these directions:

[1] Choose QUIT from the File menu.

If you choose Quit but have not yet saved your drawing
(either a new drawing or an existing drawing you have
changed), Easy-Draw displays a dialog box that asks you if
you want to save the changes you've made.

[2] When a dialog box appears, click the answer that suits you.

Easy-Draw will obey your wishes, then quit. You'll see the
GEM desktop again. Only at this point is it safe to remove
your Easy-Draw disk from the disk drive.
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Summary of First Drawings

The following list will remind you of the directions and techniques
you practiced in this section of this book. .

* How to start Easy-Draw by double clicking on the name
EASYDRAW.PRG.

* How to draw an object by bringing up the Pop-Up menu with
the right mouse button, choosing the drawing tool with the left
mouse button, holding down the left mouse button and mov-
ing the mouse to create the object, releasing the left mouse
button, moving the object where you want it, and clicking the
right mouse button to paste down the object.

* How to change an object's pattern by choosing Styles from the
Pattern menu, then choosing a pattern in the Pattern Styles
dialog box.

*  How to choose a color from the Color menu.
*  How to choose a line width from the Line menu.

* How to place text in a drawing by choosing Text from the
Pop-Up menu, drawing a text box, clicking the right mouse
button to paste down the text box, typing the text, then clicking
the right mouse button to paste down the text itself. ‘

* How to change the size of text by choosing a height from the
Text menu.

* How to save and name a drawing.

*  How to print a drawing.

* How to quit Easy-Draw.

At this point you should just start Easy-Draw again and explore
the various drawing tools and commands. Just try it out; you can-
not damage the program or your computer while exploring Easy-
Draw.

If you want to feel a little more confident before jumping in, why
not go through the exercises in this section again. Once the steps
you practice here feel comfortable and natural, then exploring
Easy-Draw will be more fun.

Above all, enjoy yourself with Easy-Draw. ‘




Master Drawings

This section describes advanced techniques that are not covered
at all in the first part of this book, or are covered only partially.
This section contains the following topics:

*  Using the Clipboard for temporary storage

* Combining objects using two windows

* Setting up colors

*  Working on patterns

* Selecting and working on more than one object at a time
‘ *  Grouping objects and working on the group

* More about printing

* Controlling the drawing surface by adjusting the zoom, scale,
ruler, grid, and snap




Using the Clipboard for Temporary Storage

You can temporarily store an object or area of one drawing on
the clipboard. One benefit of this technique is that you can make
provisional deletions from your drawing to check how they look
without permanently altering the drawing. Thus, the clipboard can
help you experiment.

Also, if your drawing is very large, it may be easier to move an
object from one part to another using the clipboard.

To store objects on the clipboard, follow these directions:

[1] Select the object or area you want to store on the clipboard.
[2] Copy or move the object or area to the clipboard.

To copy an object, select the object, choose Edit Copy, then

move the copy to the clipboard.

To move an object, select the object, then point inside it and

hold down the left mouse button, move the object over the

clipboard, then release the left mouse button. ‘

Note: When something is being stored on the clipboard, the
clipboard turns black.

To move objects from the clipboard back into the same drawing
or other file, follow these directions:

[1] Point to the clipboard, hold down the left mouse button.
A box a little larger than the clipboard will appear under the
open hand pointer.
[2] Move the box into the window.
Position the upper left corner of the box where you want the
upper left corner of the object, multiple objects, or group.
[3] Release the left mouse button to drop the objects.
The clipboard is empty after you move the objects off it.

Note: Each time you move or copy an object to the clipboard, it
replaces any object currently on the clipboard. Unlike the drawing
surface, which can have many layers, the clipboard has only one
layer.
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To move or copy objects from one part of your large drawing to
another, follow these directions:

[1] Copy or move the objects to the clipboard.
[2] Scroll the drawing.

[3] Move the objects from the clipboard back onto the drawing
surface.



Combining Objects Using Two Windows

Easy-Draw gives you two windows to work with. Two windows
are especially useful for combining objects between two Easy-
Draw drawings. By opening a second window and placing a
drawing in it, you can copy objects directly.

To combine objects using two windows, follow these directions:

[1] Choose FILE OPEN #2
[2] Choose FILE REPLACE

Easy-Draw displays the File Selector box to ask you for the
name of a drawing.

[3] Choose a drawing for window #2 in the File Selector box.
[4] Click OK
Window #2 is now the active window.
[S] Copy objects from the drawing in window #2 to the other.
Select the objects, then:
To copy, point into the object, hold down the left mouse

button, move the object to the other window where you want
it, then release the left mouse button.

Note: If you leave the second window blank, you can use it as a
sketch pad to create parts of a drawing, then move them inta win-
dow #1 as needed. Then, when you close window #2, don't save
the scratch objects, and you won't take up disk space
unnecessarily.

To activate the other window for work, point inside the window,
then click the left mouse button. The title bar of the active win-
dow is gray rather than white.



Setting Colors

You can draw your objects in four colors. The Color menu dis-
plays the current color choices. You can change the choices
through the Desktop Control Panel.

The Color Menu

You can make all objects--lines, patterns, and text--the same
color; or you can make each type of object its own color.

To make all objects the same color, follow these directions:

(1
(2]

(3]

Point to the Color menu.

Point to the number for the color you want all selected and
subsequent objects to be.

Click the left mouse button.

To set colors individually for the three types of objects (lines,
patterns, and text), follow these directions:

[1]
(2]

(3]

Choose COLOR SETTINGS
Choose the desired color number for each of the types of
objects.

You can scroll the color choices if your computer has more
than four colors by pointing to the arrows and clicking the
left mouse button.

When the color settings are the way you want them, click
OK.

Setting Up Color Choices: Control Panel

Even though Easy-Draw offers you only four colors at a time, you
can choose from many more colors so that you don't always have
only black, white, red, and blue.
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To set color choices, follow these directions:

(1]

(2]
(3]

(4]

Choose CONTROL PANEL from the Desk menu.
The Control Panel box appears, as follows:

b

CONTROL PANEL
2:33 AM | 12/ 7/86

By Lad
" e (8][L[ZHE B

e ZEE Cancel

HE B B B B B B
H EHEENENENN®BR

Choose which color you want to change on the palette.
Change the color controls to adjust the color.

Each color is a combination of red, green, and blue.
To change a color:

Click on the letter at the top or bottom of each control to in-
crease or decrease the color brightness by one step (each
color has eight steps, from 0-7)

- Or -
Point to a boxed number, hold down the left mouse button,
move the box along the control to the new number setting

(new number appears in the box when you release the left
mouse button).

When the colors are the ones you want, click the Close box
in the upper left corner of the dialog box.

Refer to Atari 520ST Computer Owner's Manual for directions for
other parts of the Control Panel dialog box.

Note: At the time of this printing, there is not a high resolution
color output device available. So, for the present, most printouts
will be black and white regardless of what colors are set.




‘ Working on Patterns

Easy-Draw provides forty patterns for filling objects. One of the
patterns is blank, or no pattern. Another pattern is a "user” pat-
tern, a pattern you can create for yourself.

Using the Easy-Draw Patterns

To fill the selected and subsequent objects with one of the Easy-
Draw patterns, follow these directions:

[1] Choose PATTERN STYLES from the Pattern menu.

The PATTERN STYLES dialog box will appear, showing the
forty patterns.

[2] Point to the pattern you want.
[3] Click the left mouse button.

‘ To change the pattern in an object:

[1] Select the object.
[2] Choose the new pattern.
Easy-Draw replaces the old pattern with the new one.
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Creating and Using Your Own Pattern

To create your own pattern for the "user” slot in the Pattern Styles
dialog box, follow these directions:

(1]

(2]

Choose USER PATTERN from the Pattern menu.
The User Pattern dialog box appears, as follows:

Fill in the grid to create a pattern.

Click the left mouse button to insert a black dot. Hold down
the left button and move the mouse to insert many dots in
one motion.

Click the right mouse button to insert a white dot (removes
a black dot). Hold down the right button and move the
mouse to erase many dots in one motion.

Hold down both buttons at the same time and move the
mouse to insert a checkerboard pattern.

Click Clear to erase all dots.
Click Invert to switch all dots to white and all white to dots.

Click Move or Copy to move or copy part of a pattern from
one place to another in the grid.
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When you click Move or Copy, a rubber band box appears
around the whole grid. Hold down the left mouse button to
size the rubber band box. Release the left mouse button,
then move the rubber band box to the area you want to
move or copy. You can press the left mouse button again to
adjust the size of the rubber band box if it is not exactly
right. Click the right mouse button to select the area to
move or copy. If you are moving, the pattern disappears.
Move the rubber band box to the new location. Click the
right mouse button to paste down the pattern at the new
location.

[2] Preview your pattern in the preview window inside the dialog
box.

The preview window shows two copies of your pattern side
by side.
[4] Click OK when the pattern is the way you want it.

Note: You can have only one user pattern per drawing. When
you change the user pattern, Easy-Draw will switch the pattern in
any object with the user pattern as soon as you make the next
change to the drawing, including saving the drawing.

To use your own pattern:

[1] Create the pattern if you haven't already done so.

[2] If you have already created and saved your pattern, choose
the user pattern box (bottom right box) in the PATTERN
STYLES dialog box.

Saving and Loading Your Patterns

After you've created your own pattern, you can save it and use it
the next time you start Easy-Draw. If you do not save the pattern,
Easy-Draw discards it when you quit Easy-Draw.

To save your pattern, follow these directions:

[1] Choose Save in the dialog box.
[2] Give the pattern a name.
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To load one of your patterns for use in a drawing, follow these
directions:

[1] Choose User Pattern from the Pattern menu.
[2] Choose Load in the dialog box.
[3] Type or choose the name of the pattern you want to use.




. Working on Multiple Objects

Just as you can work on a single object, you can also select and
work on more than one object at a time. Once you have selected
several objects at the same time, you can change them all at the
same time in most of the ways you can change a single object:
change the pattern, line width and style, and color; delete, move,
copy, align, rotate, and shadow; and group them into a single ob-
ject (see the chapter entitled "Working on a Group of Objects" for
details of grouping objects).

Note: To size or rotate multiple objects at the same time and
keep their relationships, you have to group them, then size or ro-
tate the group.

To work on a number of objects at the same time, you select an
area of the drawing.

To select more than one object (an area), follow these directions:

. [1] Be sure you are selecting rather than drawing.

The pointer must be the finger pointer, not the cross hair. If
it is a cross hair, click the right mouse button while the
pointer is over the desktop.

[2] Position the finger pointer at the upper left corner of the
area you want to select.

[3] Hold down the left mouse button and move the mouse to
draw a rubber band box around the area you want to select.

4] When the rubber band box encloses all the objects you want
to select, release the left mouse button.

All of the objects that are entirely inside the rubber band
box are selected and show their object boxes. You can select
additional objects (hold down Shift key and press left mouse
button) or unselect individual objects (hold down Shift key
and press right mouse button). You can now work on all of
the selected objects at the same time.
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To unselect multiple objects, follow one of these directions:

[*] Point to the drawing surface away from any objects, and
click the left mousc button.
If there is no free area on the drawing surface, point to the
desktop, and click the left mouse button.

- Or -

[¥] Switch to drawing by clicking the right mouse button.

What Happens to Multiple Objects

With multiple objects selected, any change you make affects all of
the selected objects the same. For example, changing the color to
red changes all the lines, patterns, and text in all the selected ob-
jects to red. The technique works and looks the same as the tech-
nique for changing the color of a single object.

Moving multiple objects, however, appears differently from mov-
ing single objects, even though the technique is the same.

Selecting multiple objects also gives you the chance to use the
Align commands on the Arrange menu. The Align commands
have no effect on single objects.

Note: If the objects have different colors, patterns, or line width
and style when you select them, the differences are retained. If
you make any change, however, all of the selected objects will
change in the same fashion (that is, a new pattern, color, and so
on).

Moving Multiple Objects

You can move multiple objects together and keep their relation-
ship to each other. While you are moving them, only boxes show-
ing the objects size move. The objects move into position when
you release the mouse button.

To move multiple objects, follow these directions:

[1] Point into one of the selected objects.
[2] Hold down the left mouse button.

A box with an X across it appears over the object, and a box
appears around the area containing all the selected objects.
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[3] With the left mousc button held down, move the X box to
the new location, then release the left mouse button.

The objects move into position at the new location. All of
the objects are still sclected.

O =]

Aligning Multiple Objects

One of the common reasons for sclected multiple objects is to
align them.

To align two or more objects, follow these directions:

[1] Sclect the objects you want to align by sclecting the arca
around them.

[2] Point to the Arrange menu.

[3] Point to the Align command you want to usc and click the
left mouse button.
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The Align commands arrange all of the selected objects as

follows:

Lerr

CENTER

Rigur
Top

MippLE

Borrom

CENTER OF
PaGe

EquaL
SPACING

All objects line up at the left edge of the
leftmost selected object.

All objects line up at the central point be-
tween the left edge of the leftmost selected
object and the right edge of the rightmost
selected object. Does not affect vertical (up
and down) positioning; only horizontal (right-
left).

All objects line up at the right edge of the
rightmost sclected object.

All objects line up at the top edge of the
topmost selected object.

All objects line up at the central point be-
tween the top edge of the topmost selected
object and the bottom edge of the bottom-
most selected object. Does not affect hori-
zontal (right-left) positioning; only vertical
(up and down).

All objects line up at the bottom edge of the
bottommost selected object.

All objects are centered horizontally or verti-
cally on the page, as you choose.

All objects are spaced apart equally, either
horizontally or vertically, as you choose.



Working on a Group of Objects

A drawing is usually a combination of many objects. Within a
drawing, you will place some objects near each other to form
some shape, such as a door on a kitchen cabinet or a piece of fur-
niture. You probably would consider each of these shapes as a
single piece, and being able to handle them as a single piece
rather than as multiple objects is very convenient and efficient.
Fasy-Draw has a command for grouping multiple objects into a
single piece so that it then becomes a single object. Making
changes to a group of objects is exactly the same as making
changes to a single object.

Creating a Group
To group objects, follow these directions:

[1] Select all the objects you want to group.

. Position the finger pointer at the upper left corner of the
area you want to select. Hold down the left mouse button
and move the mouse to draw a rubber band box around the
area you want to select. When the rubber band box encloses
all the objects you want to select, release the left mouse
button. All of the objects will show their object boxes.

You can select additional objects (hold down Shift key and
press left mouse button) or unselect individual objects (hold
down Shift key and press right mouse button).

[2] Choose CREATE GROUP from the Arrange menu.
The group will have a single object box around it.

Once you have created a group, you select it by moving the finger
pointer anywhere inside the group and clicking the left mouse
button.

An object group can be an object in another group. Using groups

‘ to form another group object is called a multi-level group. You
create a multi-level group the same way you create a group from
single objects. Working on a multi-level group is the same as
working on a single level group.
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Note: If the objects have different colors, patterns, or line width
and style when you select them, the differences are retained. If
you make any change, however, all of the selected objects will
change in the same fashion (that is, a new pattern, color, and so
on).

Dissolving a Group

To change a group of objects back to multiple objects, follow
these directions:

[1] Select the group.

Move the finger pointer anywhere inside the group and click
the left mouse button.

[2] Choose EXPLODE GROUP from the Arrange menu.

You can now work on the selected objects as multiple objects or
individually.

Note: If the main group contains several small groups, the sub-
groups are maintained until you explode their level.
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Changing a Group of Objects

Changing a group of objects is the same as changing a single ob-
ject because a group becomes a single object. When you copy a
group, the copy contains all the objects as a group, which can also
be dissolved (exploded). Ease of sizing, rotating, and copying arc
probably the major reasons to group objects rather than simply
dealing with them as multiple objects.

Changing the Size of a Group Object

Once you create a group object, you can select it as a single object
and change its size.

Note: Even if multiple objects are selected, if they are not
grouped, you can change the size of only one object at a time.

To change the size of a group object, follow these directions:

[1] Select the group object.

Move the finger pointer anywhere inside the group object
and click the left mouse button. An object box appears
around the group.

[2] Place the tip of the finger pointer in the middle of the ap-
propriate sizing marker.

The sizing markers control the following changes:

Top, bottom, left, and right sizing markers move their sides
in and out only.

Corner sizing markers move two sides in and out.

[3] Hold down the left mouse button and move the sizing
marker to change the size of the group object.

[4] When the group object is the size you want it, release the left
mouse button.
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Copying a Group Object

Making a copy of a group object is the same as making a copy of
a single object.

To copy an object or group object, follow these directions:

[1] Select the object or group object.

Move the finger pointer inside the object or the group, then
click the left mouse button.

[2] Choose CoPY from the Edit menu.
[3] Move the copy where you want it.
Move the finger pointer inside the copy, hold down the left

mouse button, move the mouse to move the copy to the new
location, then release the left mouse button.

A group object gives you the ability to copy many objects at once,
and the copy is easier to position than many individual objects.
You can also dissolve (explode) a copy of a group object to
change it back to individual objects.




‘ More About Printing

"Printing the Drawing" in the "First Drawings" section teaches you
how to print the drawing you are working on. The Size command
on the Page menu and the Output command on the File menu
can be used to perform the following additional printing chores:

* Print any drawing.

* Choose the size of paper and the direction of printing.
Print drawings on the screen.

Edit a printing list of drawings.

Save and reuse a printing list of drawings.

Set options for printer or screen printing.

Print two or more drawings in any order.

Print multiple copies of a drawing.

Note: Single disk drive owners must place their drawing disk in
. drive A before quitting from Output. Dual drive owners should

already have their drawing disk in drive B.

Printing consists of the following major steps:

To Print Any Drawing

[1] Choose Output from the File menu.

The Output menu bar replaces the Easy-Draw menu bar,
and the printing list appears.

[2] Choose Add Name from the Edit menu to add a drawing
name to the printing list.

The File Selector box appears.
[3] Type or choose the name of the drawings you want to print.
[4] Choose Start Output from the File menu.
The Start Output dialog box appears.
[5] Click on PRINTER.
. [6] Click on OK to start printing.

[7] When printing is finished, choose Quit from the File menu
to quit printing and to return to Easy-Draw.
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To Print Drawings on the Screen
[1] Click SCREEN in the START OUTPUT dialog box.
[2] Click OK to start displaying the drawings on the screen.

[3] Any time after the drawing appears on the screen, press a
key to see the next drawing,

Note: See "To set options for printer or screen printing” for ad-
ditional controls over screen printing.

The following sections provide variations of these steps for the
additional printing chores. After making your choices for the ad-
ditional chores, continue with the major steps to printing your
drawings.

Working With the Printing List

OUTPUT provides a fill-in form for you to list the drawings you
want to print or display on the screen. The printing list is espe-
cially useful when you print more than one drawing during an
output session, or if you want to print different numbers of copies
of various drawings; for example, three copies of one drawing,
five copies of another, and so on. Also, you can print the drawings
in any order by arranging the names on the list.

A\UNTITLED,LIS |

(AUT0 LGEM[
[ CHURCH .GEM |
COMPUTER , GEM

| FEATURES. GEM |
[ HOUSE  .GEM|_
 MODEL8O .GEM | _

— —ai —— —
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To Edit a Printing List

With the printing list visible on the screen, you can edit the
printing list in the following ways:

*

*

*

*

Add names

Clear the list (start a new list)
Copy names

Delete names

Add Names

(1]
[2]
(3]

Choose ADD NAME from the Edit menu.
Type or choose drawing names in the File Selector box.
Click on OK to add the names to the printing list.

The names will appear in the printing list in the order they
appear in the directory.

ITEM SELECTOR

Directory:
B:\¥,GEM
Selection!
o | EZINFO ,GEM
AUTO  .GEM ||
CHURCH . GEM

COMPUTER . GEM

EZINFOB .GEM
EZINFGG .GEM
FEATURES., GEM
FORM1640.GEM
HOUSE  .GEM
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Clear the List (Start a New List)

(1]
(2]

Choose NEW from the File menu.

If Output reminds you to save the printing list, click
Continue to discard the current list;

Or, click Cancel to stop, save the printing list, then repeat
step 1.

Copy Names

(1]

(2]

Select the drawing names in the printing list by holding down
the Shift key then clicking on each name you want to copy.

Choose DUPLICATE NAME from the Edit menu.

Delete Names

(1]

(2]

Select the drawings names in the printing list by holding
down the Shift key then clicking on each name you want to
delete.

Choose DELETE NAME from the Edit menu.

To Save a Printing List

(1]
(2]

(3]

Choose SAVE AS from the File menu.
Type a name for the printing list.
Output adds .LIS to the end of your list name.

Also, if you want, type a pathname (disk drive name, colon,
slash, and directory name).

Click on OK.
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ITEM SELECTOR

Directory:
B:\¥,LIS

| Selection:

o | DEMO LIS
COMDEX .LIS | %]

DEALER LIS

DEMO LIS

DOCUMENT.LIS
EASYDRAW. LIS

MIGRAPH LIS -
REV2 LIS

XMASAD LIS | |

________ —— S

To Reuse a Printing List

[1] Choose OPEN from the File menu
[2] Type or choosing the list name in the File Selector box
[3] Click on OK.

Setting Output Options

You can change the way printer or screen printing works, then
save your changes and retrieve them during a later printing ses-
sion. To permanently set your changes, you can establish default
choices.
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To Set Printer Options

(1]
2]

(3]

Note:

Choose PRINTER from the Options menu.
Click on your choices of options:

"Scale: best fit" shrinks or stretches your drawing to fill the
page. Use this option to fit legal and double size drawings on
one 8.5" x 11" sheet.

"Scale: full scale" prints your drawing actual size, using sev-
eral sheets, if necessary.

"Horizontal /Vertical" aligns your drawing according to the
justification option you choose: top, middle, or bottom.

Click on OK.

The Easy-Draw PAGE SIZE command controls other

printing options.

PRINTER OPTIONS
MEITINFull Scalel
Initial Form Feed: - No |
Final Form Feed:
Horizontal Justification: [Left] [fITN (Right]
Vertical Justification: [ Top | [TIXTIN [Botton
Print in Background: [ Yes | [ Ha |

| oKk | [Cancel |

To Set Screen Options

(1]
(2]

3]

Choose SCREEN from the Options menu.
Click on your choices of options:

"Wait for" determines the time between the display of each
drawing.

"Cycle" means to repeat the display over and over.
Click on O
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SCREEN OPTIONS

Seconds

Wait for: [@M [2] [5]
Cycle: nrl EEE

[ oK | [Cancel]

To Save Options Settings

[1] Choose SAVE OPTIONS from the File menu.
[2] Type a name for the options file.
[3] Click on OK.

To Reuse Previously Saved Options Settings

[1] Choose GET OPTIONS from the File menu.

[2] Type or choose the name of the options file.
[3] Click on OK.

To Set Default Options

Default means your choices are remembered and preset. Default
choices make it faster to print because you don't have to change
the settings each time you print.

[1] Set option choices for the printer and the screen.
[2] Choose Make Default from the Options menu.
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Starting Output

When all the options are set and your printing list is ready, you
can start printing. To start printing:

[1] Choose START OUTPUT from the File menu.
[2] Click on your choice of printer or screen.

[3] If the number of copies you want to print is different from
the number shown, type the number.
OUTPUT will print this number of copies of all the drawings
in the printing list. If you want different numbers of copies
for the various drawings, list them that number of times in
the printing list.

[4] Click on OK to start printing.

START OUTPUT
Device: [Plotter | [Camera |

Number of copies: Bll

ok ] [Cancel ]




’ Adjusting the Drawing Surface

You can make three types of changes to the Easy-Draw drawing
surface:

*  Adjust the ruler and the grid
*  Scroll the drawing

* Zoom the drawing

Adjusting the Ruler and the Grid
You can adjust the ruler and the grid in the following ways:

* Turn the ruler display on and off

*  Adjust the grid markings on the page
* Turn the grid display on and off

* Turn grid snap on and off

Turning the Ruler On and Off
When the ruler is on, you can visually align objects on specific
measurement markings. Easy-Draw does not scale for you.

[*] To turn the ruler on or off, choose PAGE RULER DISPLAY
ON/OFF from the Page menu.

Adjusting the Grid Markings on the Page

You can adjust the spacing between the grid markings on the
page. When you do this with SNAP ON, Easy-Draw automatically
uses the grid settings to snap during drawing or moving of objects.

You can choose from the following spacings:
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Imperial Metric

1/32 inch 1 millimeter
1/16 inch 2 millimeters
1/12 inch 5 millimeters
1/10 inch 1 centimeter
1/8 inch 2 centimeters
1/4 inch 3 centimeters
1/2 inch

1inch

To choose a different spacing for the grid, follow these directions:

[1] Choose PAGE GRID SPACING
[2] In the dialog box, choose the spacing you want.
[3] Click OK.

You can adjust the spacing at any time. Even if the ruler is not on
display, the change of spacing will affect the spacing of the grid.

Turning the Grid Display On and Off

The grid display provides visual guidance for positioning objects.
Particularly if grid snap is on, seeing the grid dots will help you
see how and where to align your objects. If you don't need or like
seeing the grid, you can turn it off.

[*] To turn the grid display on or off, choose GRID DISPLAY
ON/OFF from the Page menu.

There is a practical and aesthetic limit to the number of dots that
appear on the screen. If there are too many dots, you'd see only a
mess of lines filling the drawing surface, and it would be difficult
to see your objects. Easy-Draw limits the number of dots, de-
pending on the zoom level of your drawing window.

At ZOOM NORMAL level, the smallest grid spacing whlch would
be visually accurate is elght dots per inch; that is, 1/8"™ inch
spacing between dots.

If you use ZOOM AREA to zoom in closer to your drawing, Easy-
Draw will show visually accurzﬁe spacings if you have the grid set-
tings closer together than 1/8" inch. At very great magnification
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of your drawing, you can see the grid dots for 1/ 32 inch. Note,
however, that thg dots will appear in the window spread farther
apart than 1/32' inch because the space between them has been
magnified along with the objects in your drawing.

Recommended Grid Settings

Zoom level Imperial Metric
Zoom Full " 5l i
Page 1/4",1/2" 1 2mm or larger
Zoom " "

1/8",1/4", 2mm or larger
Normal 121"

Turning Grid Snap On and Off

Grid snap helps you precisely align your objects with one another.
When grid snap is on, the drawing cursor is snapped to the near-
est grid dot as if they were small magnets. Likewise, when you
move an object, the object's top left corner will be lined up on the
nearest grid dot. Grid snap is most helpful with regular geometric
objects. The size of new objects is adjusted to the grid lines when
you paste them down. If you want to create objects in sizes that
fall between the grid dots, you can turn off grid snap or select a
smaller spacing.

[*] To turn on or off grid snap, choose PAGE GRID SNAP
ON/OFF from the Page menu..

Note: When grid snap is on, it is also recommended that you
turn on the grid display.

Scrolling the Drawing

You can create drawings that are as large as the sheet of paper
you will be printing on. (Use the Page Size command to tell Easy-
Draw what size paper you will be printing on.) The Easy-Draw
window shows only a part of a sheet at any one time. When your
drawing is larger than the window, you will naturally want to be
able to move to the parts of the drawing that are outside the win-
dow so you can continue your work. Moving the drawing so that
the parts outside the window come into view is called scrolling.
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To scroll a drawing, use one of the following techniques:

*  Point to one of the sliders, hold down the left mouse button,
then slide the slider in the direction you want to see. Release
the mouse button to move the drawing.

Point to the area inside the scroll bar that is outside the slider,
then click the left mouse button. The slider moves into the
part of the scroll bar where you click and scrolls the drawing
by the height or width of the window.

Point to one of the arrows in the appropriate scroll bar, and
click the left mouse button. Each click moves your view of the
drawing in the direction of the arrow; that is, the up arrow
moves your view towards the top of the drawing. Each click
moves the drawing by the amount of the space between the
ruler markings. (See "Adjusting the Markings on the Ruler"
for details of the spacing on the ruler.)

Zooming the Drawing

When you start Easy-Draw, you will see your objects in the actual
size they will be printed. This is called normal view, or ZOOM
NORMAL. For fine detail work, you may want to see a closer view
of your objects. To get a closer view, you zoom in on the drawing.
Similarly, you may want to see how objects are placed on the
whole page. To see the whole page at once, you zoom out from
the drawing to FULL PAGE view.

You have four choices for zooming your drawing:

Zoom level To see

AREA Closer view of drawing
FuLL PAGE Whole page at once
NoRMAL Objects actual size

Last Previous zoom level
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Zoom Area

To zoom in closer, follow these directions:

[1] Choose ZOOM AREA

[2] Move the mouse pointer to the upper left corner of the
drawing area you want to zoom.

[3] Hold down the left mouse button, draw a rubber band box
around the area you want to zoom, then release the left
mouse button.

Easy-Draw expands the shortest side of the area inside the
rubber band box to fill the window. You control the amount
of zoom by the size of rubber band box you draw. If you
draw a small box, you zoom in very close to your drawing. If
you draw a large box, you zoom only a small amount.

You can use the ZOOM AREA command repeatedly to move in
closer to the drawing.

Note that you can still scroll your drawing, regardless of the
amount you have zoomed into your drawing.

You can add objects to your drawing while you are zoomed in
close to your drawing. Note, however, that the objects you draw
while zoomed in will be smaller when you look at them in ZooM
NORMAL. Switch to normal view to see the actual size. When you
zoom in, text objects enlarge only to the nearest available point
size. The available point sizes are shown on the Text menu.

Note: You can create or edit text objects only in ZOOM
NORMAL.

Zoom Full Page

To zoom out from your drawing to see the whole page, choose
ZooM FULL PAGE. You'll see the whole sheet and the positions
of your objects on it.

If your objects are very small, they will not be very clearly defined.
Zoom in to see them more clearly.

You are advised to use ZOOM NORMAL while drawing objects
rather than using ZOOM FULL PAGE. If you add objects to your
drawing while you are at full page view, they will be larger when
you look at them in ZOOM NORMAL.
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Note: Although graphics are accurate at all zoom levels, text
objects size and formatting are only accurate at ZOOM NORMAL.

Zoom Normal

After you have zoomed in or out, you may want to see the actual
size of your objects. To see the actual size, you return to normal
view by choosing ZOOM NORMAL.

Note: This is the level to do all your text work at.

Zoom Last

You can set up two different levels of zoom during your work to
assist you as you draw. The ZOOM LAST command gives you a
convenient way to switch between two levels of magnification.

To take advantage of the ZOOM LAST command, follow these
directions:

[1] Use ZOOM AREA to set up the smaller level of
magnification.
The smaller level of magnification is the view that shows
more of the total drawing.
To set a zoom level between full page and normal, switch to
full page view, then use ZOOM AREA to decrease the magni-
fication between full page and normal.

[2] Use ZOOM AREA again to set up the larger level of
magnification.
The larger level of magnification is the view that shows the
objects up close.

[3] Choose ZOOM LAST to switch between the two levels.

Note: If you choose ZOOM NORMAL or ZOOM FULL PAGE,
Z0oOM LAST will switch to that view. Be sure you are ready to give
up one of your zoom levels before you choose ZOOM NORMAL or
Z00OM FULL PAGE.




Sample Drawings

This scction provides two sample drawings that illustrate various
tasks you can usc Easy-Draw to complete. These two samples are
especially rich in merging of text and graphics to producce
brochures. You'll sce from these two samples how Easy-Draw can
be usced for desktop publishing.

The directions for the sample drawings assume that you arc la-
miliar with the following tcchniques, which are covered in the
"First Figurcs" scction, or refer to the index for page number.

*
*
®
*

*

Sclecting objects
Changing (o Point Modce
Sizing objccts

Choosing commands
Resizing GEM windows

In addition, you nced (o know how to move an existing object:

[
2]
131

[4]

Sclect the object

Point insidc the object.

Hold down the left mousc button and drag the object to the
new location.

Rclease the mouse button.




Desktop Publishing:
Merging Text and Graphics

This sample drawing illustrates the following techniques:

*  Merging GEM files

* Loading an outside text file
* Reformatting text blocks

* Breaking text blocks

*  Stretching groups

Note: Single-Drive Systems Remember to replace your Easy-
Draw Master Disk with your Drawing Disk once you have started
Easy-Draw.

Dual-Drive Systems Remember that you need to change the
path in the File Selector box from A: to B: if you keep your
Drawing Disk in drive B.

Note: The directions for this sample drawing assume that you
are familiar with some basic techniques, which are covered in the
"First Figures" section, and listed at the beginning of this section.

[1] Start Easy-Draw and load (FILE REPLACE REPLACE)
EZINFOB.GEM.

[2] Merge (FILE REPLACE MERGE) the second drawing,
EZINFOG.GEM.

[3] Select the large empty text block below the Migraph logo,
choose EDIT TEXT, then click in the text block again.

You should see the following:

S—— Y E——
Fasy — Draw:
The Affordable Answer
to Desktop Publishing/
@ Produce Professional Quality | these powedur
v Materials with Your ST!

s

o
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Desktop Publishing
[4] Press F1 (to load a text file), then select EZINFO.TXT.

Text_Line Pattern Color

‘ Desk File Page lomm Edit her
f'""’"""”“""'w—-.;mm o ST
r
ey
- o

oo

Qudan Lo .
[e

o
Resize the text box to a little less than one-half its width.

5]

me[ T

B

[6] Move the arrow to end of the last visible paragraph and click
the mouse button to position the cursor there.

Line_Pattern Color

Arrange Tex
s vt YOS T -
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[7] Press F10 to break the text block.

el

18

[8] Move the new text block to right, then stretch it downward
as shown. Click the right mouse button to paste down the

new text block.

mol

L) S = s Ie

[9] Select the Migraph logo that is above and left of the text.
Choose EDIT COPY, then move the logo copy below the first

text column.




Desktop Publishing

[10] Stretch logo to fill the area below the two text blocks.

Desk File Page Zoon Edit Arrange Text Line

ttern Color

ALy gt L R o o EZ INFOB , GEMAp S £}
ARR d
pad
Now anyone can create n & hury? Quickiy put | omgec Uteteomng e
nmnnm:'-lu.-nlm-na together new fiyers by
with their St and Easy m
raoh. Easy~Oraw i3 & . Ohangethe | Onsemennimamme. |
Sbjets . Chn. 39 Pasemns + user definadle) —
onenmd gre
Ful OEM
and V'\l"'l roady PLUS:
NING.  camera ready copy). Plip and Mirror
= Oraw 13 fast, feble, Single GEM File Format
and tun to usel your
COpy. When you want muli— potential by leting you be & New Arc Command
€0lors. use Easy—Draw 1 Make Demer At designer, Wy, New Arange Command
0 one version
Load ASCH Piles —
Q‘ N, s o)
AAA »
AAAN
29 3 B B
AAA
=
of

Now anyone can create
protessional masenialy

Desk File Page Zoom Edit Arran:

In & hurry? Quickly put
tegether new fiyers by
tfrom

Text Line Pattern
g g

Color

2B ey

with their St and
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™I
and you're ready 1o ge (with

<
Easy— Oraw i3 fas, fasible,

ang tun to uset your
potential by letting you be &
Dewer ar¥s designer. and wrier.
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Sizing Entire Graphics Drawings
This sample drawing illustrates the following techniques:

*  Deleting text

* Grouping objects

* Resizing a whole drawing

*  Using two windows

* Copying an object to another page

Note: If you skipped the first sample drawing, please see the
note at the beginning of the Desktop Publishing sample about
drawing disks.

Note: The directions for this sample drawing assume that you
are familiar with some basic techniques, which are covered in the
"First Figures" section, and listed at the beginning of this section. ’

[1] FILE REPLACE REPLACE HOUSE.GEM.

[2] Click on the text in the upper left corner and drag it to the
Trash can.

r‘
rs
=

S
g
=ic
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[3] Choose PAGE SELECT ALL, which displays object boxes
around all parts of the house.

Desk File Page Zoom Edit Arrange Text Line Pattern Color

[4] Choose ARRANGE CREATE GROUP to turn the house into a
single object.

[5] Resize house to approximately 2" x 2".

Desk File Page loom Mrrange Text iine Pattern Color
Selete | i
1 L o
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Desk File Page Zoom Edit Arrange Text Line Pattern Color
T 23 4

o'r

Resize the window to a little less than one-half the screen.

(6]
[7] Choose FILE OPEN #2 to open a second window.
[8] FILE REPLACE REPLACE EZINFO.GEM into window #2.

ANew Low Pric;
o i— O
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[9] Click inside window #1 to make it active, then drag a copy
of the house into the blank area in window #2.

Ry 5

New Lo

w Pri

69
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Summaries

This section provides a quick summary for easy reference of
Migraph Easy-Draw commands, features, and techniques. When
you just want to know something quickly, more as a reminder
than to learn something completely new, this section will suit you.

This part of the manual is divided into these chapters:

Menu Commands Brief descriptions of the action performed by
each command on the menus

Screen Description of the screen

Techniques Summaries of the steps for every Easy-Draw
‘ command and feature

Hints Hints on ways to use Easy-Draw more effec-

tively and efficiently.




Menu Commands

The descriptions of the commands appear in the order they ap-
pear in the menus. All of the menus are shown together on the
next page. Directions for using the commands appear in the two
chapters entitled "Techniques" and "Hints."

Note: Menus that display * followed by a letter offer keyboard
shortcuts for the experienced user. The * symbol means hold.
down the Alternate key and press the letter key.




Menu Commands

Control Panel

EASY-DRAW info..

Install Printer

v Normal
Bold
Light
Italic
Outlined
Underlined
Justify

v Sizg mee

7 Pt
/18 Pt 1/8"
14 Pt
18 Pt 1/4"
28 Pt
36 Pt 1/2"
s Fants ==

Styles...

Replace...
Open #2..

Save Fi
Save As...

Output...
Quit

Delete
Undelete
~~~~ Hodify -~~~
Copy b
Flip &F
Mirror M
Rotate iR
Open/Close %0
===~ Hodes ~==~~~
Size L04
v Stretch X
----- Edft oo
frc / Pie
Polyline
Text

73

[ Page
Size ...
-~~~ Rylers ==~~~
Display ON &T
~~~~~ Grid ~~~~~~
Spacing ...

Display ON %G
Snap ON %S

Erase All  %E

Put in Front
Put in Back

een SHACING ="
Center of Page

Even Distance

None Styles...
Transparent
______ Shadow
.......... User Pattern..
-~Hidtri3'l'
-~ Ends =~
J/ — w—
s

TMMOOOODWe

Settings...
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Desk Menu

EASY-DRAW info..

A o e AN OO AN BN DOP BT 00 DO B 00 OO0 D00 800 D00 B0 o0 e

Control Panel
Install Printer

EASY-DRAW INFO [DESK]
Use Desk EASY-DRAW INFO to see the following information:

Version number

Number of objects currently in each window
Total number of objects still available

* DT button

* OK button

Version Number shows you which revision of Easy-Draw you
have.

Objects in Window 1 and Objects in Window 2 show you how
many objects make up the drawing in each window.

# Objects Available shows you the total number of objects you
still have room for.
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DT Button empties the Trash can of the last object you deleted.
Use the DT button when you run out of memory before you have
finished your drawing.

Note: Once you click the DT button, the objects in the Trash can
can no longer be recovered for use in your drawing.

OK Button makes the information box disappear so you can con-
tinue to work on your drawings.

Easy-Draw

Copyright (c) 1985,86 MIGRAPH,INC

Version! 2.00

Consumer Applications Division
Paul Mazurek,

Kevin Mitchell, Doug Delong, Jim Wilson

L

For a description of the Control Panel command, see the chapter
entitled "Setting Colors," and see also your Atari 520ST Computer
Owner's Manual.

The Install Printer command is used currently to enable the sys-
tem to quick print (Alternate-Help keys) the screen correctly on
your dot matrix printer. Note that the pixels per line must be set
at 960.
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File Menu

The REPLACE and SAVE AS
commands display the File

Selector box where you can
Rueljlacf'é v tell Easy-Draw which
..M,WEEE.,...W.'..'..W.. drawing you want to work
on or store.
Save F1
Save Rs...
Output...
Quit
ITEM SELECTOR
Directory:
B:\¥, GEM
i ¥, GEM Selection:
o | EZINFO . GEM
AUTO JGEM [ )
CHURCH . GEM
COMPUTER., GEM

EZINFOB .GEM

EZINFGG .GEM
FEATURES.GEM [

FORM1040.GEM | | [Cancel |
HOUSE . GEM

REPLACE [FILE]

Use FILE REPLACE to replace the drawing currently in the win-
dow (or a blank drawing surface) with another drawing, or to
merge drawings. Easy-Draw displays a pop-up menu containing
REPLACE and MERGE. When you choose one of these, Easy-
Draw displays the File Selector box to ask you for the name of the

drawing. Sec "Hints" for information about using more than one
disk drive.



Menu Commands 77

Shall the file to be loaded
replace or be merged with
the current drawing??

If you chose REPLACE and the drawing currently in the window or
changes to a drawing have not yet been saved, Easy-Draw asks
you if you want to save or discard them.

OPEN #2 [FILE]

Use FILE OPEN #2 to open a second drawing window, which will
have a blank, untitled drawing surface.

When two windows are open, activate the other window for work
by pointing inside it, then clicking the left mouse button.

Each window has its own settings for grids, page size, line type,
and so on. Remember: as you switch between windows, your set-
tings switch, too.

After you choose FILE OPEN #2, OPEN #2 is replaced with
CLOSE #2.

CLOSE #2 [FILE]

Closes the second drawing window. If you have not saved the
drawing or changes to an existing drawing, Easy-Draw asks you if
you want to save or discard them.

FILE CLOSE #2 replaces FILE OPEN #2 after you have opened the
second window.

SAVE [FiLE] F1

Use FILE SAVE to save changes you've made to an existing draw-
ing. If the drawing you are saving has never been saved before (a
new drawing), Easy-Draw automatically switches to FILE SAVE
As.
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SAVE As [FILE]
Use File Save As to:

* Save a new drawing

* Save an existing drawing on a dilferent disk
* Save an existing drawing with a different name

To save your drawing, type a name for your drawing in the File
Selector box (see the description of the File menu for a picture of
the File Selector box). Include disk drive and pathname informa-
tion if you want to store the drawing on a different disk drive or
directory.

OuTPUT [FILE]

Use FILE OUTPUT to print your drawing, either on your printer or
on the screen. When you choose FILE OUTPUT, a new menu will

m appear:

Save Options...

Start Output...

Quit

New Add Nanme,.. Scfeen...
Open. .. Duplicate Hame Printer...
g!qge Delete Name 4

§é"’e .nsl [ ]

bet Options. .. Make Default

Note: Before you can print a drawing, you must have saved it.

To print your drawing:

Note: Single disk drive owners must place their drawing disk in
drive A before saving drawings. Dual drive owners should already
have their drawing disk in drive B.

[1] Choose OUTPUT from the File menu.

The Output menu bar replaces the Easy-Draw menu bar,

and the printing list dialog box appears.
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2]

(3]
4l
(5]

(6]

Fill in the names of the drawings you want to print.
The list can contain from one drawing to thirty-six drawings.

Use the commands on the Edit menu to add names to the
list, delete names from the list, or clear the list to start a new
list.

Choose FILE START OUTPUT.

The START OUTPUT dialog box appears.

Click on the device you want to "print" on, and enter the
number of copies you want.

Click on OK to start printing.

Important: If you have only one disk drive, you must insert
your Easy-Draw Master Disk now before quitting from
OUTPUT.

When printing is finished, choose QUIT from Output's File
menu to return to Easy-Draw.

You have several options for controlling printing, including
printing to the screen. With screen printing, you can create a slide
show. You can control the time between pictures and can choosc
to make the show repeat until you stop it. For details of setting
the screen printing options, see the chapter entitled "More About
Printing," which contains full descriptions of all the printing
features.

QuIT [FILE]

Use FILE QUIT to quit Easy-Draw. If a drawing or changes to an
existing drawing have not yet been saved, Easy-Draw asks you if
you want to save or discard them.

When Easy-Draw quits, you will return to the GEM desktop.
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Page Menu
Size ... 'l’
e RUlory ~wees
Display ON &T
~~~~~ Grid ~=====
Spacing ...
Display ON %G
Snap ON WS
Select A1l A
Erase All &E
SizE [PAGE]

Use PAGE SIZE to choose the size of paper you want to draw and

print on. The page size you select determines if you will work in

inches or centimeters. Selecting a metric page size sets Easy- ‘
Draw to use metric grid size and rulers.

Note: If you like to draw on a metric grid but want to print
drawings on imperial paper sizes, choose a metric page size for
drawing then choose an imperial page size just before your final
save.

You can also choose which direction you will be drawing and
printing on the sheet.
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v 8.5 x 11 Letter|
[ 8.8 x 13 Legal |
[ 11.8 x 17 Double|
(14,8 x 21,0

[(21.8 x 29.7 Din R4
[29.7 x 42,8 Din R3]

RULER DisPLAY ON/OFF [PAGE] *T

Use PAGE RULER DISPLAY ON to turn on the ruler to see the size
and position of objects in your drawing. The ruler shows the size
of measurements you set using Page Ruler Spacing.

Use PAGE RULER DISPLAY OFF to turn off the ruler again.

GRID SPACING [PAGE]

Use PAGE GRID SPACING to set the measurements that will ap-
pear on the drawing surface. You can choose sizes shown in the
following dialog boxes.
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Ruler/Grid Settinas: HETRIC |
1 mn ln |
102 mn O2en

fRuler/Grid ‘Settings ;

w3z s

(] 1/16 174 ]
Oz Ow i {5 mm O3 cn
Owe [t

[ CANCEL ]

GRID DisPLAY ON/OFF [PAGE] *G

Use PAGE GRID DISPLAY OFF to turn off the visual display of the
drawing grid.

PAGE GRID DISPLAY ON turns the grid back on. With grid display
on, dots appear in squares on the drawing surface. In zoom nor-
mal, dots will appear accurately spaced according to the setting
selected.

Note: Grid spacings finer than 1/ 8" of an inch should only be
used when zoomed in closer than zoom normal.

GRID SNAP ON/OFF [PAGE] *S

Use PAGE GRID SNAP ON to turn on grid snap, which is turned
off when you buy Easy-Draw. Grid snap can help you align vari-
ous parts of your drawing by moving the beginning and ending
points of an object to one of the grid points. Grid snap has no ef-
fect when you draw frechand sketches.

Note: Resizing a grouped object with Grip Snap on using the
EDIT SIZE option may result in objects that do not expand or
shrink proportionally. To assure proportional resizing with the
EDIT SIZE option, turn off grid snap.
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When you turn off Grid Snap, the beginning and ending points

can be anywhere on the drawing surface, but alignment can be

more difficult. The various Align commands will help you align
. any objects that must be aligned in your drawing.

Use PAGE GRID SNAP OFF to turn off grid snap again.

SELECT ALL [PAGE] *A

Use EDIT SELECT ALL to select every object in a drawing all at
once.

ERASE ALL [PAGE] *E

Use PAGE ERASE ALL to erase everything from the drawing sur-

face; gives you a clean sheet without saving anything currently on
the drawing surface.

. Zoom Menu

Area

Normal oN
Full Page
Last L

AREA [ZOOM]

Use ZOOM AREA to select the part of the drawing you want to
expand to fill the whole window.

To zoom an area:

. [1] Choose the AREA command, then move the mouse pointer
onto your drawing.

[2] Hold down the left mouse button starting at the upper left
corner of the area you want to zoom.
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[3] Move the mouse until the rubber band box encloses the area
you want to zoom.

[4] Release the left mouse button to zoom the selected area to
window size.

The shortest side of the rubber band box will expand to the full
window size in that direction. For example:

EMPTY1.GEM

N

— s
= =
m—

The opposite dimension of the rubber band box may be expanded
greater than the size of the window in that direction.

Note that the amount of zoom is controlled by the size of the
rubber band box you draw; the smaller the box, the closer in you
zoom.

To return the drawing to normal size, choose ZOOM NORMAL.
To return to the view you had just prior to using ZOOM AREA,
choose ZOOM LAST.

Note: You can create or edit text objects only in zoom normal.
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NORMAL [ZooM]  *N

Use ZOOM NORMAL to return to the normal size of your drawing
after having chosen either ZOOM FULL PAGE or ZOOM AREA.

Normal size means the size the objects will be shown and printed
(actual size).

FuLL PAGE [ZOOM]

Use ZOOM FULL PAGE to see how your drawing is positioned on
the sheet. When you choose FULL PAGE, Easy-Draw draws a
miniature picture of a sheet of paper with your drawing sketchced
on it. This picture only approximates how your drawing will fit on
the sheet when it is printed. Details and clarity are sacrificed to
show approximate positioning.

FULL PAGE will appear gray on the Zoom menu while your
drawing is zoomed to full page. Choose ZOOM NORMAL to scc
your drawing at its normal size and to add objects to it.

Note: You can create or edit text objects only in Zoom Normal.

LAST [ZooM]  *L
Use ZOOM LAST to return to the zoom view you had of your
drawing just before using the most recent Zoom command.

ZOOM LAST lets you switch between two magnifications (zoom
levels) of your drawing.
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Edit Menu

Delete
Undelete

wams Hagify -~
Copy e
Flip WF
Mirror M
Rotate R
Open/Close %0

e Hadog o
Size 4

v Stretch wx

~~~~~ Edit ~~=~m~
Arc / Pie
Polyline
Text

DELETE [EDIT]  DEL

Use EDIT DELETE to remove an object or an area of a drawing.
This command does the same action as dragging an object to the
Trash can.

To delete something from a drawing:

[1] Select the object or an area of the drawing
[2] Choose EDIT DELETE

You can reverse the deletion by choosing EDIT UNDELETE.

UNDELETE [EDIT]  UNDO

Use EDIT UNDELETE to reverse the effect of the Delete com-
mand or to return an object from the Trash to the drawing sur-
face. The object returns to the upper left corner of the active
drawing.
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Copy [EDIT]  *C

Use EDIT COPY to get a copy of existing objects.
To copy an existing object:

[1] Select an object or an area of the drawing
[2] Choose EDIT COPY

Copy will appear gray on the Edit menu if nothing is
selected.

If you are in drawing mode, this command will automatically
put you in point mode.

[3] Point to the copy, hold down the left mouse button, and
move the copy where you want it

[4] Release the left mouse button to paste down the copy

FUP [EDIT] *F

Use EDIT FLIP to flip over the selected objects, either to the side
or up and down.
[1] Select the objects you want to flip.
[2] Choose EDIT FLIP.
The EDIT FLIP pop-up menu appears:

[3] Choose the flip direction, Left/Right or Up/Down.

The objects flip around their center, staying in the same
place on the drawing surface.

MIRROR [EDIT] *M

Use EDIT MIRROR to create a mirror image object of the same
size and shape next to the selected object. With EDIT MIRROR,
you can quickly build tiles and other symmetrical shapes. Or, if
you know the object you are drawing is symmetrical, you need to
draw only half, or perhaps only a quarter, of it, which will save
you half the drawing work.
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[1] Select the objects you want mirror images of.
[2] Choose EDIT MIRROR.
The EDIT MIRROR pop-up menu appears:

Left/Right
Up/Domn
CANCEL

[3] Choose the mirror direction, Left, Right, Up, or Down.

Easy-Draw creates an object of the same shape and size but
a mirror image of the original. The new object and its origi-
nal touch along the side you chose in the pop-up menu.

RoOTATE [EDIT] *R

Use EDIT ROTATE to rotate the selected object or area of the
drawing 90 degrees counterclockwise (to the left).

Important: If you want to rotate several objects at once and
maintain their orientation to each other, then make sure they are
grouped into a single object first.

To rotate an object or area:

[1] Select the object or area.
[2] Choose ROTATE from the Edit menu.

ROTATE will appear gray on the Edit menu if nothing is
selected.

You may use this command repeatedly on the selected object or
area.

Note: Text does not rotate.
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Oren/CLOSE [EDIT] *O

Use EDIT OPEN/CLOSE when you want to change the open/close
status of a polyline or sketch object

If a polyline or sketch object is open, it will become closed.

If a polyline or sketch object is closed, it will become open.

Before After Before After

Size [EDIT] *Z

Use EDIT SIZE to change the effect of the sizing markers on an
object from Stretch (see STRETCH command). When EDIT SIZE is
on, there are only four sizing markers on the object box around
the selected object. Moving a sizing marker enlarges or shrinks
the whole object in all directions and dimensions proportionally,
from the current center.

Note: If grid snap is on, the object may not expand or shrink
proportionally nor hold the position of the center. To assure pro-
portional resizing and current center position, turn off grid snap.
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Compare with EDIT STRETCH, which resizes objects in the direc-
tions and dimensions that you move a particular sizing marker.

STRETCH [EDIT] *X

Use EDIT STRETCH to change the effect of the sizing markers on
an object from SIZE (see SIZE command). When EDIT STRETCH
is on, there are eight sizing markers on the object box around the
selected object. Moving a sizing marker enlarges or shrinks the
object in that direction and dimension. The center of the object
slides in the direction of the enlargement or shrinkage.

Compare with EDIT SIZE, which resizes whole objects
proportionally.

ARC/PIE [EDIT]

Use Edit Arc/Pie to change the angle between the two legs of a
wedge or an arc after the object has been pasted down.

Notice that the Edit menu name stays black to indicate that you
are in an editing mode. Also, a panel appears at the top of the
screen that constantly displays the beginning and ending angles as
well as the percentage of the arc.
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To change the angle, follow these directions:

(1]
(2]
3]
4l

Select the wedge or arc.

Choose PIE/ARC.

Select the object again.

Change the angle with the arrow keys:

The right and left arrow keys move the upper leg (or end) by
S degrees.

The up and down arrow keys move the lower leg (or end) by
5 degrees.

Hold down the Shift key and press the arrow keys to move
the legs (or ends) by 1/2 degrees.

Note: These keys also adjust the legs (or ends) while you are
drawing a new wedge or arc.

POLYLINE [EDIT]

Use EDIT POLYLINE to change the shape and size of part of a
polyline or sketch object, to smooth areas of a sketch object, and
to break a polyline into smaller pieces.

(1]
(2]

Select a polyline or sketch object.
Choose EDIT POLYLINE.

Notice that the Edit menu name stays black to indicate that
you are in an editing mode. Also, a panel appears at the top
of the screen that tells you about the F1 and F10 keys (see
below).

A marker appears at the nearest point on the polyline. You
can use this point or select any other point on the polyline by
pointing with the mouse and clicking the mouse button, or
by pressing the arrow keys, which cycle through the points if
the object is closed (if the object is open, the selection of
points stops at each end of the object).
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[3] Point inside the point marker, press the left mouse button,
and drag the point to resize and reshape the object.

Press Delete key to delete a point.

Press Insert key to insert a point. A dialog box will appear to
ask you Before or After the current point. "Before" means to
the left and above the current point. "After" means to the
right and below the current point.

Press Undo key to reverse your last editing action (move, in-
sert, or delete).

Press F1 to open or close the object.

Press F10 to break the object into two objects. Both will be
selected, but they exist as separate objects. Both objects will
be open after splitting.

Text [EDIT]

Use EDIT TEXT to change the contents of a text box. Once you've
selected the text box, choose EDIT TEXT, then select the text box
again. Easy-Draw puts a cursor in the upper left corner of the text
box so you can edit the text.

Notice that the Edit menu name stays black to indicate that you
are in an editing mode. Also, a panel appears at the top of the
screen that tells you about the F1, F2, and F10 keys (see below).

The arrow keys move the cursor up, down, right, and left. You
can position the cursor with the mouse by pointing and clicking
the left mouse button. If you hold the left button down, the open
hand pointer appears so that you can move the text box. After you
move the text box, the cursor appears in the upper left corner of
the text box.

Note: The default text format is justified. Press Return key when
you do not want a line justified; for example, at the end of a
paragraph or for blank lines between paragraphs.

You can use the following keys to edit text:
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Key
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Action

Arrow keys
Home
Backspace
Delete
Shift-Delete

Clear
(Shift-Home)

Return
Esc
F1

F10

Move cursor up, down, right, and left

Moves cursor to upper left corner of text box
Erases to the left

Erases the character to the right of the cursor
Erases to the end of the line

Erases entire text block

Starts a new line and prevents justification
Reformats the text

Loads an ASCII file into current text block. If
you load a word processing file that contains
special characters (e.g., for formatting), Easy-
Draw will substitute spaces. To avoid this,
save your text files in ASCII file format rather
than in word processing format.

Switches between justified and non-justified
text.

Breaks text block at the cursor position and
puts remaining text into a new text block be-
low the original.

In addition, you can use the mouse during text editing. Position
the mouse pointer and click the left mouse button to position the
cursor. Press the right mouse button to end text editing and re-

format the text.
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Arrange Menu

| Arrange [
Put in Front
Put in Back
***** froup weme
Create i+
Explode -
***** flign ~~~~r

Bottom

e Sogeing e
Center of Page
Even Distance

PuUT IN FRONT [ARRANGE]

Use ARRANGE PUT IN FRONT to place the selected object or area
in front of all parts of the drawing that overlap or underlap it.

)

PuUT IN BACK [ARRANGE]

Use ARRANGE PUT IN BACK to place the selected object or area
behind all parts of the drawing that overlap or underlap it.
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CREATE GROUP [ARRANGE]  *+

Use CREATE GROUP to group all objects in a selected arca of a
drawing as a single unit.

To create a group:

[1] Select the area with the objects you want to group.
[2] Choose CREATE GROUP from the Arrange menu.

CREATE GROUP will appear gray on the Arrange menu if
nothing is sclected.

After you group part of a drawing, all the pieces become essen-
tially a single piece, as if drawn as one object. You can also group
two or more groups. Choose EXPLODE GROUP to reverse the
CREATE GROUP command.

ExPLODE GROUP [ARRANGE]  *-

Use EXPLODE GROUP to release the parts of a group joined to-
gether with ARRANGE CREATE GROUP.

To explode a group:

[1] Select the group object.

EXPLODE GROUP will appear gray on the Arrange menu if
nothing is selected.

[2] Choose EXPLODE GROUP from the Arrange menu.

After you choose EXPLODE GROUP, you can work with the indi-
vidual pieces of the former group.

ALIGN LEFT [ARRANGE]

Use ALIGN LEFT to align all objects within the selected area with
the left side of the object that is farthest to the left.

Note: All of the Align commands (except CENTER OF PAGE) re-
quire that two or more objects are selected.
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ALIGN CENTER [ARRANGE]

Use ALIGN CENTER to place all objects within the sclected area
at the horizontal center between the left side of the object that is
farthest to the left and the right side of the object that is farthest
to the right.

ALIGN CENTER does not affect the vertical placement of objects.
See ALIGN MIDDLE to adjust vertical placement to the vertical
center.

ALIGN RIGHT [ARRANGE]

Use ALIGN RIGHT to align all objects within the selected area
with the right side of the object that is farthest to the right.

ALIGN TOP [ARRANGE]

Use ALIGN TOP to align all objects within the selected area with
the top side of the object that is farthest up.

ALIGN MIDDLE [ARRANGE]

Use ALIGN MIDDLE to place all objects within the selected area
at the vertical center between the top side of the object that is
farthest up and the bottom side of the object that is farthest
down.

ALIGN MIDDLE does not affect horizontal placement of objects.
See ALIGN CENTER to adjust horizontal placement to the hori-
zontal center.

ALIGN BOTTOM [ARRANGE]

Use ALIGN BOTTOM to align all objects within the selected area
with the bottom of the object that is farthest down.

CENTER OF PAGE SPACING [ARRANGE]

Use SPACING CENTER OF PAGE to move the selected object(s) to
either the horizontal or vertical center of the page. After you
choose CENTER OF PAGE, the following secondary pop-up menu
appears:
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Horizontal

Vertical |
CANCEL

EVEN DISTANCE SPACING [ARRANGE]

Use ARRANGIL EVEN DISTANCE o space cqually several selected
objccts. This command requires that more than one object be se-
lected. After you choose EVEN DISTANCE, the following sce-
ondary pop-up menu appears:

Horizontal
Vertical
CANCEL

Text Menu

v Normal
Bold
Light
Italic
Outlined
Underlined
Justify

S 7o MChty
7 Pt

v 18 Pt 1/8"
14 Pt
i8 Pt 1/4"
28 Pt
36 Pt 1/2"

~~= Fants =~~~
Styles...
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NORMAL [TEXT]

Use TEXT NORMAL to make all selected and subsequent text ap-
pear without any of the choices on the Text menu (turns off at
once all choices that are on) so that you don't have to choose each
one individually to turn it off.

BoLD [TeXT]

Use TEXT BOLD to make selected and subsequent text appear
bold face. Choose TEXT BOLD again to turn off bold face. Choose
TEXT NORMAL to turn off all choices for text.

LIGHT [TexT]

Use TEXT LIGHT to make selected and subsequent text appear
light. Choose TEXT LIGHT again to turn off light text. Choose
TEXT NORMAL to turn off all choices for text.

ITALIC [TEXT]

Use TEXT ITALIC to make selected and subsequent text appear
italicized (slanted). Choose TEXT ITALIC again to turn off italics.
Choose TEXT NORMAL to turn off all choices for text.

OUTLINE [TeXT]

Use TEXT OUTLINE to make selected and subsequent text appear
with outlines around the letters and numbers. Choose TEXT
OUTLINE again to turn off outlined text. Choose TEXT NORMAL
to turn off all choices for text.

UNDERLINED [TEXT]

Use TEXT UNDERLINED to make selected and subsequent text
appear underlined. Choose TEXT UNDERLINED again to turn off
underlining. Choose TEXT NORMAL to turn off all choices for
text.
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JUSTIFY [TEXT]

Use TEXT JUSTIFY to right align the text within the text box.
Spaces are added between the words to fill out the lines so that
each line stretches from one side of the text box to the other. If
you press the Return key, that line will not be justified.

If you select two or more text boxes then choose TEXT JUSTIFY,
the justify status of each text box changes. If text is not justified, it
becomes justified; if text is justified, it becomes unjustified.

AEIGHT [TEXT]

Use TEXT HEIGHT to chose a size for selected and subsequent
text. The size of text is measured by a system called points. The
numbers in the Text Settings dialog box represent point sizes for
letters. Points are a measurement used by printers and typeset-
ters. There are 72 points per inch. Thirty-six points equals one-
half inch. A point size of 10 points generally produces eight lines
per inch. Ten points is the size of elite typewriter type.

Seven point text will print out fine on supported laser printers or
24-pin printers but may not have enough resolution on 9-pin dot
matrix printers to produce the desired quality.

STYLES [TEXT]

Use TEXT STYLES to choose a text style (font) from as many as
five styles. Your choice affects selected and subsequent text.

navailable |
navailable 2
navailable 3
navailable 4
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You will always have the default style, which is provided with
Easy-Draw. As other fonts are made available and installed on
you Easy-Draw Master disk, they will be loaded, and the names
will be shown. If no other fonts are available, Easy-Draw show
"UNAVAILABLE 1-4" in gray.

Line Menu
Use the Line menu to choose:

* Type of line you want to draw. For solid lines, you also have
the choice from several line widths. The patterned lines are all
thin lines. You can also choose None to draw objects without
borders. If you also have no pattern, then the object will be
invisible.

Shape of the ends of lines; you can choose a type for each end
of a line; the left column is for the beginning of the line
(where you started drawing the line); the right column is for
the end of the line.

~~ Hidths ~~

-~ Ends -~

J— \/—

- >
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Pattern Menu

Styles...
Transparent
Shadow

User Pattern..

STYLES [PATTERN]

Use PATTERN STYLES to choose:

*

Which pattern you want to fill the currently selected part of
the drawing.

Which pattern you want to fill the next solid object you draw.

*

l LT

NH
L]

To create your own pattern, choose USER PATTERN on the
Pattern menu.

TRANSPARENT [PATTERN]

Use PATTERN TRANSPARENT when you want selected objects to
be "see through" so that they let objects behind them show
through.

Use PATTERN TRANSPARENT a second time when you want the

‘ objects to be opaque and to hide parts of other objects that are
behind them.
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If you select two or more objects then chose PATTERN
TRANSPARENT, the transparent status of each object changes. If
an object was transparent, it becomes opaque; if an object was
opaque, it becomes transparent.

SHADOW [PATTERN]
Use PATTERN SHADOW to add or remove shadows on the se-
lected objects. Shadows give objects a three-dimensional look.

You must choose PATTERN SHADOW after an object is drawn.
PATTERN SHADOW does not automatically apply to objects you
draw subsequently.

Shadows always show on the bottom and right side of the object.
To add or remove a shadow on an object:

[1] Select the object.
[2] Choose Edit Shadow.

Note: If you select two or more objects then choose PATTERN
SHADOW, the objects change their shadow status. If an object had
a shadow, it loses it; if an object had no shadow, it gets one.

USER PATTERN [PATTERN]

Use USER PATTERN to create your own pattern. You can imitate
an existing pattern, then alter it, or you can create a wholly new
pattern.
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See the chapter entitled "Working on Patterns" for directions for
creating your own pattern.

LoAD USER PATTERN [PATTERN]

Use LoAD USER PATTERN to retrieve a pattern you created and
saved previously with the USER PATTERN command. Easy-Draw
asks you for the name of the file you saved your pattern in. After
you load the pattern, you can modify it for use during this session,
then discard the modifications or save them for future use.

SAVE USER PATTERN [PATTERN]

Use SAVE USER PATTERN to save the pattern you create with the
USER PATTERN command. By saving the pattern, you can usc it
again the next time you start Easy-Draw. If you do not save the
pattern, it is discarded when you quit Easy-Draw.

Easy-Draw adds the characters .PAT to the end of each pattern
file name.
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Color Menu

TMMOMOODWOWo

00 20 200 00 200 D00 BN DO POE O DOE D0 00 D00 P00

Settings...

Use the color swatches to choose a color for all lines, patterns
(fill), and text. Only as many colors appear as your computer can
draw.

To choose individual colors for lines, patterns, or text, use COLOR
SETTINGS.

You can adjust the available colors through the Control Panel.
See the chapter entitled "Setting Colors" for the techniques for
adjusting the available colors.

SETTINGS [COLOR]

Use COLOR SETTINGS to choose individual colors for lines, pat-
terns (fill), and text. The numbers on the main Color menu set
the color for all three at once.
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I [Line ] <OEWAHS] ] )|

[T eomads]] )|
|[Mext] RODAAE]] ||

To choose a color, click on the number for the color you want.
Use the arrows to reveal color numbers not in view. You will have
four colors displayed using medium resolution color.
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See the chapter entitled "The Menu Commands" for pictures of
the menus and dialog boxes.



Techniques

The techniques are listed in alphabetical order. Following the
techniques you'll find a list of hints for applying some of the
techniques.

Adjusting the Grid

*  Grid display: Choose PAGE GRID DISPLAY ON/OFF.
*  Grid snap: Choose PAGE GRID SNAP ON/OFF.

*

Grid spacing:
Choose PAGE GRID SPACING.
Choose grid spacing.
Click OK.

Adjusting Wedges and Arcs

*  New objects:

During creation, press left or right arrow keys to move up-
per leg (upper end) by five degrees.

Press up or down arrow keys to move lower leg (lower end)
by five degrees.

Hold down Shift key and press the arrow keys to move the
legs (or ends) by 1/2 degrees.

*  Existing objects:

When wedge or arc is one of the currently selected objects,
choose EDIT CHANGE ARC.

Select wedge or arc to edit.

Press arrow keys as described for new objects to adjust the
angle of the legs (or ends).

Aligning Objects

*  New objects:

Turn on Grid Snap and Grid Display.

Place objects on grid points that are aligned.
* Existing objects:

Select the area containing the objects.

Choose the ARRANGE ALIGN command that suits your
purpose.
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Canceling a Command

To cancel out of all drawing commands (box, line, and so on),
editing of arcs, text, and polylines, moving of objects, and sizing or
stretching of objects:

Hold down the left mouse button.

Press the right mouse button, so both buttons are down.

Then, release both buttons at the same time.

Changing Line Width and Style
Note: Line width and style apply to all objects except text.

*  New object:

Point to the desired line example on the Line menu.
Click the left mouse button.
Draw the object.

* Existing object:
Select the object.
Point to the desired line example on the Line menu.
Click the left mouse button.

Changing to Point Mode

*  After completing a drawing mode command:

Press the left mouse button while pointing to the desktop
area

- or --
Press the right mouse button while the drawing Pop-up
menu is displayed.
= OF ==
Choose EDIT SIZE or EDIT STRETCH
Several other menu commands will also automatically put

you into point mode; such as PAGE SELECT ALL and EDIT
COPY.

Choosing Menus, Commands, and Dialog Box Choices

Note: You can choose menus, commands, and dialog box
choices whether you're in drawing or point mode (the mouse
pointer can be either cross hair or finger). The menus are not ac-
tive, however, while you are in the middle of a drawing command.
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*  Menus: Point to the menu name.

*  Commands:

. Choose the menu.

Point to the command name.

Click the left mouse button.
* Dialog box choices:

Point to your choice.
Click the left mouse button.

Coloring Objects

*

New object:
Point to the desired color sample on the Color menu.
Click the left mouse button.
Draw the object.

Note: This technique chooses one color for lines, patterns, and
text. To choose a color for only one of the types of objects, choose
COLOR SETTINGS, then choose the desired color for the type of
object.

* Existing object:
Select the object.

Point to the desired color sample on the Color menu.
Click the left mouse button.

Note: This technique also chooses the color for subsequent new
objects.

Copying Objects

*  One object:
Select the object.
Choose EDIT COPY.
Move the copy where you want it.
*  Two or more:
Select the area containing the objects.
Choose EDIT COPY.
Move one of the objects to the new position. The rest will
follow when you paste the first one down.

Note: Copies are displayed 1/2" to the right and down visually,
no matter what zoom you are currently using.
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Creating Your Own User Pattern

Choose USER PATTERN from the Pattern menu.

Click the left mouse button to insert dots.

Click the right mouse button to erase dots.

Hold down both mouse buttons to insert checkerboard.

Click Clear to erase all dots.

Click Invert to reverse dots and white.

Click Move or Copy to move or copy part of a pattern to an-
other part of the grid, size the rubber band box, move the
rubber band box to the area to move or copy, (resize rub-
ber band box if necessary by holding down the left mouse
button), click right mouse button to select area, move rub-
ber band box to new location, click right mouse button to
paste down.

Click OK.

Note: The pattern will appear in the "User" slot in the PATTERN
STYLES dialog box.

Note: Click Save to keep pattern for future Easy-Draw sessions.

Displaying the Ruler
* Ruler display: Choose PAGE RULER DISPLAY ON/OFF.

Drawing Objects

* To draw:

Click right mouse button to bring up the Pop-Up menu of
drawing tools.

Point to the desired drawing tool.

Click the left mouse button.

Move cross hair pointer to desired starting point.

Hold down the left mouse button and move mouse to draw
object.

Release left mouse button and move mouse to position
object.

If necessary, hold down left mouse button again to adjust
size and direction of object.

Click right mouse button to paste down object.

* To cancel:

Hold down left mouse button.
Press right mouse button.
Release both mouse buttons together.
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Editing Text

* To start:

Select the text object.
Choose EDIT TEXT from the Edit menu.
Select the text object again.

*  Moving in text box:

Press the arrow keys to move the cursor up, down, right,
and left.

Press Home to move the cursor to upper left corner of text
box.

- or -
Position the mouse pointer and click the left mouse button.
*  Adding text:

Position cursor.
Type new text.

* Erasing text:

Backspace to erase to the left of the cursor.
Delete to erase to the right of the cursor.
Shift-Delete to erase to the end of the line.
Clear (Shift-Home) to crase entire text block.

* Reformatting:
Press Esc.
- or --
Click on a sizing marker.
—-or -
Wait a couple of seconds for automatic reformatting
*  Stop editing:
Click right mouse button (also reformats text box).
* Load an ASCII file
Press F1 to load an ASCII file into the current text block.
*  Press F2 to toggle right justify on/off.

* Breaking text blocks
Press F10 to break a text block at the cursor position. The
remaining text splits off into a new text block below the
original. You are placed in edit mode in the new text block.
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Erasing/Deleting Objects

*  To delete:

Sclect the object.
Choose EDIT DELETE.

-— Or -
Move object to Trash can.
* To reverse deletion: Choose EDIT UNDELETE.
Objects appear in upper left corner of active window.

*  To empty Trash can:

Choose Desk EASY-DRAW INFO.

Click on DT.
Note: Emptying Trash can cannot be reversed.
*  Save for later:

Select the object.
Move object to Clipboard.

Filling Objects with a Pattern

* New object:
Choose PATTERN STYLES.
Point to the desired pattern.
Click the left mouse button.
Draw the object.
*  Existing object:
Select the object.
Choose PATTERN STYLES.
Point to the desired pattern.
Click the left mouse button.
Note: This technique also chooses the pattern for subsequent
new objects.

Grouping Objects and Exploding a Group

*

To group:
Select the area containing objects.
Choose ARRANGE CREATE GROUP.
*  To explode:

Select the group.
Choose ARRANGE EXPLODE GROUP.
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Inserting Text

*

*

*

To start:

113

Click right mouse button to bring up Pop-Up menu.

Point to Text.
Click left mouse button.

Point where you want text to begin.

Draw rubber band box.
Click right mouse button.
Type text.

-- Or --

Press F1 to load an ASCII file into the current text block.
For help, see "Using File Selector Box" in "Hints."

Press F2 to toggle justify.

Press F10 to break a text block at the cursor position.

The remaining text splits off into a new text block below the
original. You are placed in edit mode in the new text block.

Press the arrow keys to move the cursor up, down, right, and

left.

Press Home to move the cursor to upperceft corner of text

box.
- Or -

Position the mouse pointer and click the left mouse button.

Hint: If you want to add large blocks of text to a drawing,
create the text in a word processor or text editor, save the
text in ASCII format, then load the text block with F1 key.

When you use F1 key to load a text block that is bigger than
the text box, Easy-Draw loads all the text that will fit in
memory. You can then stretch the text box to see the rest of
the text. Use F1 with F10 to quickly layout an entirc page.
See the "Sample Drawings" section for an example.

To stop: Click right mouse button.

To cancel:

Hold down left mouse button.

Press right mouse button.

Release both mouse buttons together.

[r=; =
his 1s an example 01

Justified text which fills the
inside of the text box. k
J

-

fas! — N

&1

o

&
During <Creation

This is an example of
Justified text which fills the
inside of the text box.

Complete

Text Cursor
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Merging Drawings

Choose FILE REPLACE.
Click MERGE in the Pop-up menu ’
Choose or type the name of the next drawing in the File
Selector box. If you want to start a new drawing, type a new
name.
Click OK.
If the window contains a new drawing or a changed draw-
ing, Easy-Draw asks if you want to save or discard it.

Moving Objects

*  During drawing;
Release both mouse buttons when you've finished drawing

object.
Move mouse.

* New text object:

While typing or editing text, move text box by holding down
left mouse button until open hand pointer appears, then
moving mouse to position text box.

*  Existing object: ‘
Make sure you are in point mode.
Select the object.
Point into the object.
Hold down the left mouse button.
Move mouse to move object to new location.
Release left mouse button to drop object.

Note: If you have more than one object selected, you'll see a box
with an X in it over the pilot object which moves for the purpose
of establishing the new location. At the same time, all the selected
objects will be surrounded by a thin box.

Opening and Closing a Second Drawing Window

* To open:

Choose FILE OPEN #2.
Click OK.

* To close: .
Choose FILE CLOSE #2.
If second window contains a new drawing or a changed
drawing, Easy-Draw asks if you want to save or discard it.
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Printing Drawings

Store (save) the drawings.

Choose FILE OUTPUT.

Choose EDIT ADD NAME.

Type or choose the name of the drawings.
Choose FILE START OUTPUT.

Click on PRINTER.

Click on OK

When printing is finished, choose FILE QUIT.

Putting Objects in Front or in Back

*  Put in back:

Select the object.
Choose ARRANGE PUT IN BACK.

*  Put in front:

Select the object.
Choose ARRANGE PUT IN FRONT.

Note: See "Hints" for clever uses of the PUT commands.

Quitting Easy-Draw

Choose FILE QUIT.
If the window contains a new drawing or a changed draw-
ing, Easy-Draw asks if you want to save or discard the cur-
rent drawing.

Replacing the Drawing in a Window

Choose FILE REPLACE.

Click Replace in the Pop-up menu

Choose or type the name of the next drawing in the File
Selector box. If you want to start a new drawing, type a new
name.

Click OK.
If the window contains a new drawing or a changed draw-
ing, Easy-Draw asks if you want to save or discard it.

Rotating Objects

Select the object.
Choose EDIT ROTATE to rotate object 90 degrees
counterclockwise.
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Scrolling Drawings

*  Short scroll:

Click an arrow in scroll bar to move drawing one grid line.
Long scroll:

Point to the gray area in the scroll bar next to the slider,
then click the left mouse button. The drawing scrolls the
height or width of one window.

- Or -

Move slider in scroll bar to move drawing by width or height
of screen. Moving a slider uses the same technique as
moving an object.

*

Selecting/Deselecting Objects

Before selecting an object, the mouse pointer must be the finger
pointer. If the pointer is the cross hair pointer and you are not in
the middle of a drawing command, press the left mouse button
while over the desktop.

*

One or a group:
Point inside object or group.
Click left mouse button. Object box and sizing markers
appear.

*  Two or more:

Hold down left mouse button.

Draw box around objects.

Release left mouse button. All objects totally inside area
have object boxes and sizing markers.

,-Or--

Hold down Shift key, point inside another object or group,
and press left mouse button. Object box and sizing markers
appear.

*  To unselect all:

Point to drawing surface or desktop where there are no ob-
jects, then click the left mouse button.

Shadowing Objects: 3-D Look

*  To add or remove shadow:

Select the object.
Choose EDIT SHADOW.
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Sizing Objects

* SIZE MODE on:

Select the object.
Point to one of the four sizing markers (all four do the same
thing).
Hold down left mouse button.
Move marker in direction of size change:
Away from center for larger.
Toward center for smaller.
Release left mouse button when object is the size you want
it.
Note: Object changes size proportionally so that it holds its
original shape and center point.

Stretching Objects

*  STRETCH MODE on:

Select the object.
Point to one of the cight sizing markers; each stretches or
shrinks differently:
Top middle for top edge
Bottom middle for bottom edge
Left middle for left edge
Right middle for right edge
Upper left corner for top and left edges at same time
Upper right corner for top and right edges at same time
Lower left corner for bottom and left edges at same time
Left right corner for bottom and right edges at same time.
Hold down left mouse button and move mouse in dircctions
desired.
Release left mouse button when the object is the size and
shape you want it.

Note: Object changes both size and shape; the center point
slides in the direction of the change.

Starting Easy-Draw

*

From a floppy disk:

Insert the Easy-Draw Master Disk in drive A.
Turn on your Atari ST.
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When a window appears with a list of the files on your Easy-
Draw disk, move the mouse until the arrow rests on the
name EASYDRAW.PRG.

This is called pointing.

Double click (press and release very rapidly twice in succes-
sion) the left mouse button.

*  From a hard disk

Open the EASYDRAW folder on your hard disk.
Double click on EASYDRAW.PRG.
See Appendix A for full details of hard disk usage.

Storing/Saving Drawings

*  New drawing:

Choose FILE SAVE AS.
Type name of drawing in File Selector box.
Click OK.

* Revised drawing: Choose FILE SAVE.

Transparent Objects

*  Existing object:
Select the object.
Choose PATTERN TRANSPARENT.
* To opaque:
Select a transparent object.
Choose PATTERN TRANSPARENT.

Note: TRANSPARENT lets objects show through from behind,
even if the transparent object has a pattern.

Vertical Text Labels

Often, business graphics require vertical text labels for charts and
graphs. This can be achieved very simply. First, select the text la-
bel, then stretch the text label so that only one letter will fit on
each line. See the illustration below.
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*  An area:

Choose ZOOM AREA.
Move mouse pointer to the beginning of the area you want .

to zoom.
Hold down left mouse button and draw box around area you

want to fill the window.
Release left mouse button.

* To whole page: Choose ZOOM FULL PAGE.
*  Actual size: Choose ZOOM NORMAL.
* Last zoom: Choose ZOOM LAST.

Note: See "Hints" for clever uses of ZOOM AREA.
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Arranging Object Layers: Put Commands

PUT IN FRONT and PUT IN BACK on the Arrange menu place ob-
jects all the way at the back or the front. What if you want an ob-
ject in the middle of the pack? Then, you must arrange the other
objects so that the one you want in the middle is shuffled there in
the process.

For example, suppose there are three squares: black, red, and
green. Suppose you want the green square in the middle with red
in front and black in back:

[1] Select black square, then choose ARRANGE PUT IN BACK.
[2] Select red square, then choose ARRANGE PUT IN FRONT.

The green square is now in the middle.

Closing Up Polyline and Sketch Objects

With the polyline tool, you can draw multiple-sided objects, such
as triangles or hexagons. With the sketch tool, you can draw any
free-hand object.

To change the open/close status of polyline or sketch objects:

[1] Select the objects.
[2] Choose EDIT OPEN/CLOSE.

Selected objects that are open will close. Selected objects that are
closed will open.

Creating a Perfect Square

The box drawing tool creates both squares and rectangles. To
draw a square, you have to decide when the object is square, then '
paste it down. To draw a perfect square, follow these directions:
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(1]
(2]
(3]
[4]
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Choose PAGE GRID SNAP ON to turn on grid snap.

Choose PAGE GRID DISPLAY ON to turn on the grid display.
Choose the box drawing tool.

Draw your square to the grid lines.

When you paste down the square, Easy-Draw snaps it to the
grid lines and makes it a square.

Grouping Text and a Graphic Box

Grouping a text object and a surrounding graphic box lets you
automatically reformat the text when you stretch the box. This
can be very useful, for example, for organization charts and other
business presentations.

(1]
(2]
(3]
[4]

Select the text object.
The text box becomes visible.

Stretch the text box so that it is a little smaller than the
graphic box.

Select both the text object and the box object and create a
group so that they become one object.

Stretch the object as needed to reformat the text.

Note: Remember that if you need to edit the text, you need to
explode the group first.

Hiding Part of an Object

After drawing a complex object, you may want to erase a small
portion. If this cannot be done by either deleting an object or by
editing a polyline, you can place a non-transparent object with a
white or no-line style over the arca. See the following illustration.
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Creating Pie Charts

[1] Turn GRID SNAP on and display the grid to make it easier to
align the pie segments. .
A grid setting of 1/8" works well. This assures that each
segment starts from the exact center of the pie.

[2] Draw the wedges.
Remember that you can change the beginning and end an-
gles during creation. Use the cursor keys so that you have
exact angles that are easy to match.

[3] Once the wedges are drawn, fine tune the pie chart by se-
lecting different patterns for each wedge, adding text labels
and arrows, and shadowing an exploded section, if you like.

Example Pie Chart

37.5%

37.5% 259%

Redrawing the Screen

If the screen looks irregular for any reason, ask Easy-Draw to re-
draw the screen:

[1] Move the pointer to a slider in one of the scroll bars.
[2] Click the left mouse button.

Shrinking Text Block Height to Fit Text

If you create a tall text block then type text that does not fill it,

you'll want to shrink the text block height to fit the text. If you .
don't, when you switch to full page zoom, text will fill the full text

block, which means text appears to flow into a part of the drawing

where it won't be printed. Shrinking the text block height assures

that full page zoom constrains the text to its actual area size.
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[1] Select the text block.
[2] Drag up one of the sizing markers on the bottom of the text
block until the box fits the height of the text.

As an alternative:

With the cursor after the last character, press F10 to break
the text block.
Delete the new (empty) text block (EDIT DELETT:).

Using File Selector Box

Resides using the File Selector Box to load and save filcs , you can
use it to change the path and when changing disks.

Changing the Path

The path consists of a disk drive designator (e.g., A:), directory
names (if any), and a designation for the type of files to list (such
as files with the extension .GEM).

Warning Do not press Return while the cursor is in the path
line of the File Selector Box. Always move the mouse pointer to
the list of files and click the mouse button first.

*  Changing drive designator

[1] Press the left arrow key to move the cursor to the colon.

[2] Backspace over the letter, then type the new letter.

[3] Move mouse pointer to file box and click left mousc button.
* Changing the file extension

[1] Backspace over the three letter extension (e.g., GEM).

[2] Type the new extension (e.g., TXT).

[3] Move mouse pointer to file box and click left mouse button.

Note The first time the File Selector Box appears, it shows the
default drive (the drive Easy-Draw startéd from). After that, cach
window can have its own path.

Changing Disks

You'll change disks when you want to load pictures or text files
that are on a different disk.

[1] Replace the disk in the disk drive.

[2] Position mouse pointer on "X" box in the upper lcft corncr
of File Selector Box.

[3] Click left mouse button for the list of files on the ncw disk.



Appendix A. Installing Easy-Draw on a Hard Disk

Important: All steps in the following directions should be per-
formed using backup copies of your Easy-Draw disks and after
you have backed up your hard disk for safety.

These procedures are somewhat technical in nature and should
be performed by qualified personnel only. Read all steps before
proceeding.

(1]

(2]
(3]

(4l
5]

(6]

(7]
(8]

]

Boot with your hard disk boot disk so you can perform the
following steps.

Create a new folder on your hard disk called EASYDRAW
Copy the following files from your Easy-Draw Master Disk
into the EASYDRAW folder on your hard disk:

EASYDRAW.PRG EASYDRAW.RSC
OUTPUT.PRG OUTPUT.RSC

Create another new folder on your hard disk called GEMSYS.

Copy all the files from the folder GEMSYS on you Easy-Draw
Master Disk into the GEMSYS folder on your hard disk.

To do this after creating the folder on the hard disk, open
both GEMSYS folders by double clicking their names. You
can copy about 10 files at a time by selecting them with a

box.

Copy the file GDOS.PRG from the AUTO folder on the
Easy-Draw Master Disk into the AUTO folder that is already
on your boot-up floppy disk.

Copy the sample drawings (.GEM files) from the Easy-Draw
Drawing Disk to the EASYDRAW folder on your hard disk.
Copy the file ASSIGN.SYS from the Easy-Draw Master
Disk to your normal hard disk boot-up floppy disk. (root
directory).

Using your favorite editor (like FAST ST-Editor from
Migraph), edit the PATH command in ASSIGN.SYS to in-
clude the proper drive designator for your hard disk (C: or
D:or E: or Fo).

The next time you reboot your system with your normal boot up
disk, you should see the GDOS 1.1 Resident message.

To start Easy-Draw now:

(1]
(2]

Open the EASYDRAW folder on your hard disk.
Double click on EASYDRAW.PRG.



Appendix B. Creating New Drawing Disks

This appendix describes which files should be on drawing disks
for various system configurations. The following sections reflect
the configuration of disks inside your Easy-Draw package.

Note for All Systems When you save an existing drawing, Easy-
Draw creates a backup file (.BAK extension). Delete unneeded
.BAK files to save disk space.

Single Drive Systems
Insert a drawing disk in the drive after you start Easy-Draw.

*  Single-Sided Drives (Model SF 354 disk drive)

[1] Format a new blank disk single-sided.

[2] Copy these files from the original drawing disk:
GEMSYS Folder OUTPUT.PRG OUTPUT.RSC

The disk will have about 150K for (.GEM) drawings.

* Double-Sided Drives (Model 314 disk drive)

[1] Format a new blank disk double-sided.

[2] Copy these files from the original drawing disk
GEMSYS Folder OUTPUT.PRG OUTPUT.RSC

The disk will have about 500K for (.GEM) drawings.

Dual Drive Systems
A drawing disk should be in drive B while using Easy-Draw.

* Single-Sided Drives (Model SF 354 disk drive)

[1] Format a new blank disk single-sided.

[2] Copy OUTPUT.PRG from the original drawing disk.
The disk will have about 290K for (.GEM) drawings.

* Double-Sided Drives (Model 314 disk drive)

[1] Format a new blank disk double-sided.

[2] Copy OUTPUT.PRG from the original drawing disk.

The disk will have about 550K for (.GEM) drawings. For more
space, see Appendix C, "Hints for Double-Sided Drives."



Appendix C. Hints for Double-Sided Drives

The information in this appendix applies only if you have
1040ST with a built-in double-sided disk drive or a 520ST with a
Model SF314 disk drive for drive A.

Hint for Single Drive Owners Copying an entire disk file-by-[ilc
is not only tiresome but also it is easy to insert the wrong disk
while swapping. We recommend that before attempting the fol-
lowing procedures that you buy or borrow a second disk drive.

Note The Easy-Draw disks are formatted single sided. You nced
to format two new blank disks double sided before procceding.

Creating a New Master Disk (All Systems)

[1] Copy all the files from your original Easy-Draw Mastcr disk
onto a blank, double-sided formatted disk.

Important Do not do a diskcopy. A quick way to copy all the

files is to drag the A icon (original Master disk) over window

B (blank disk) and drop the A icon inside the window.

[2] Copy OUTPUT.PRG file from the Easy-Draw Picture disk
onto the new master disk.

You now have one disk that contains all the Easy-Draw files.

Dual Drive System Only

Use the entire second blank formatted disk to store drawings.



Appendix D. Using Additional Fonts

Important: To assure proper operation of Easy-Draw on your
ST and your printers, use only tested GEM fonts available from
Migraph.

Easy-Draw uses standard proportional space GEM fonts for both
color and monochrome displays and each output device. A font
style called "Swiss" is provided with Easy-Draw. This font is simi-
lar in style to Helvetica™ .

Additional fonts are available from Migraph in font packs, which
include directions for proper installation. When you purchase a
font pack, place the font documentation here in your Easy-Draw
manual.
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Arranging objects in layers
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Mirror (Edit) 87
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Normal (Zoom) 60, 85,
119

Open #2 (File) 68, 77,
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Open (Edit) 89, 120

Outline (Text) 98

Output (File) 48, 54,
78, 115
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Printer 52
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Quit (File) 79, 115

Quit (Output File) 115
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Rotate (Edit) 88, 115
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(Page) 55, 81, 110

Save (File) 77,118

Save As (File) 78,118

Save User Pattern
(Pattern) 103

Screen 52

Select All (Page) 67, 83

Settings (Color) 109

Shadow (Pattern) 102,
116

Size (Page) 80

Size Mode (Edit) 89,
117

Spacing Center of Page
(Arrange) 96

Spacing Even Distance
(Arrange) 97

Start Output (Output
File) 115

Stretch Mode (Edit)
64,90, 117
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Styles (Pattern) 35, 101,
112
Styles (Text) 99
Text (Edit) 63,92
Top Align (Arrange)
42, 96
Transparent (Pattern)
101, 118
Unavailable 1-4 (Text)
100
Undelete (Edit) 86, 112
Underlined (Text) 98
User Pattern (Pattern)
36, 102, 110
Control Panel, setting
colors 33
Control Panel (Desk) 75
Control Panel dialog box
34
Controlling zoom size 84
Copies of Easy-Draw 13
Copy (Edit) 87, 109
Copying
group 46
objects 87, 109
objects between
windows 32
Create Group (Arrange)
67,95
Creating
group 43,112
pattern 110
square 120
pie charts 122
Cursor movement (text
box) 111

- Default options, setting 53
Default style (text) 100
Degrees of rotation 88
Delete (Edit) 86, 112
Deleting objects 86, 112
Deleting objects, reversal

86, 112
Deselecting objects 116
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Desk menu
Control Panel 75
EASY-DRAW info 74
Install Printer 75
picture 74
Desktop publishing 61
Dialog boxes
choosing in 108
Color Settings 105
Control Panel 34
Easy-Draw Info 75
File Selector 76
Grid Spacing 82
Install Printer 75
Page Size 81
Pattern Styles 19, 101
Printer Options 52
printing list 48
Screen Options 53
Start Output 54
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in) 108
Text Style 99
User Pattern 36, 103
Different name for
drawing 78
Direction of rotation 88
Display of pie/arc angles
91

Displaying the ruler 110
Dissolving a group 44
Draw canceling 110
Drawing a Box 17
Drawing objects 110
Drawing surface, adjusting
55
Drawings
aligning parts 82
giving a different name

magnifying parts 59

merging 62, 114

opening a second 77

previewing page 85

printing 26, 78, 115

replacing in window 76,
115
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scrolling 57, 116

storing 13

zooming 58
Drop-down menus 73
DT Button 75

Easy-Draw
copics 13
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pop-up menu 17
quitting 27, 79, 115
start screcen 16, 106
starting 15, 117
EASY-DRAW info (Dcsk)
74,112
Edit Copy 109
Edit Dclete 112
Edit menu
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Copy 87
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Flip 87
Mirror 87
Opcen 89
picturc 86
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Polylinec 91
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Size 89
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Text 92
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Edit Rotate 115
Edit Undclete 112
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sketch 91
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Editing text 111
Editing text, normal zoom
84
Editing text, stopping 111
Emptying Trash can 112
Equal Spacing align 42
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Erasc All (Page) 83

Erasing objects 112

Erasing objccts, reversal
112

Erasing text 111

Even Distance pop-up
mcenu 97

Even Distance Spacing
(Arrange) 97

Explode Group (Arrange)
95

Exploding a group 112

F1 key (load ASCII file)
63
F10 key (break text block)
04
File loading (ASCII) 111
Filc menu
Closc #2 77
Open #2 77
Output 78
picture 76
Quit 79
Replace 76
Save 77
Save As 78
File Selector box 76
Files, PAT (cxtension)
103
Filling
box with a pattern 19
objeets with patterns
101, 112
Fitting text blocks to text
122
Flip (Edit) 87
Fonts (text) 99
Formatting text
Bold 98
fonts 99
Hceight 99
Italic 98
Justify 99
Light 98
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normal 98

Outline 98

point size 99

Styles 99

turning all off 98

Underlined 98
Front, putting objects in

115

Full Page (Zoom) 59, 85,
119

Get Options 53

Graphics and text grouping
121

Grid
adjustments 55, 107
Display on/off (Page)

56, 82, 107, 120

dots limits. 56
markings, adjusting 55
settings, recommended

Grid Snap on/off (Page)
57, 82, 107, 120, 122

Grid snap and sizing 82,
89

Grid snap and stretching
90

Grid Spacing (Page) 56,
81, 107

Grid Spacing dialog boxes
82

Grid spacing
recommendation 82
Group
changing 45
changing size 45
copying 46
creating 43
dissolving 44
multi-level 43
working on 43
Group Create (Arrange)
67

Grouping objects 95, 112
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exploding 95, 112
Grouping text and graphics
121 L

Hard disk installation 124
Height (Text) 99
Hiding parts of objects
121
Hints
arranging object layers
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closing objects 120
creating a square 120
creating pie charts 122
graphics and text
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grouping text and
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121 4"
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object closing 120
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121

objects in layers 120

pie charts 122

polyline closing 120

redrawing the screen
122

screen redrawing 122

shrinking text blocks
122

sketch closing 120

squares 120

text and graphics
grouping 121

text block shrinking 122

Imperial grid spacings 56
Inches page grid, setting
80
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122

Italic (Text) 98

J
Justify (Text) 99
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*C (Edit Copy) 87
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arc and wedge
adjustment 107

arrow keys 111

arrow keys (Edit Text)
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Backspace (Edit Text)
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Clear = Shift-Home
(Edit Text) 93

cursor movement (text
box) 111

Delete (Edit Text) 93

Esc (Edit Text) 93

F1 (ASCII file loading)
63,111

F1 (Edit Text) 93

F2 (Edit Text) 93

F10 (break text block)
64,93, 111, 122

Home (Edit Text) 93,
111

Return (Edit Text) 93

Shift-Delete (Edit Text)
93

*G (Page Grid Display

on/off) 82
*L (Zoom Last) 85
*M (Edit Mirror) 87

*N (Zoom Normal) 85
*O (Edit Open/Close)
89

*R (Edit Rotate) 88
*S (Grid Snap on/off)
82

*T (Page Ruler Display

on/off) 81
*X (Edit Stretch) 90
*Z (Edit Size) 89

Alternate-Help (Quick

Print) 26
Alternate-Help keys
(Quick Print) 75

Labels, vertical text 118

Landscape printing
direction (sideways) 80

Last (Zoom) 60, 85, 119

Layer objects 120

Left Align (Arrange) 42,
95

Letter size, changing 24

Levels of zoom 58

Light (Text) 98

Line menu, picture 100

Line styles and shapes 100

Line width and style
changes 108

Load (File Replace) 62

Load User Pattern
(Pattern) 103

Loading an ASCII file (F1)
63, 111

Loading your patterns 38
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Magnifying part of a
drawing 59, 83

Markers, sizing (Size) 89

Markers, sizing (Stretch)
90

Memory usage 12
Menus
all illustrated 73
Arrange 94
canceling pop-up 18
choosing from 108
Color 33,104
Desk 74
Edit 86
File 76
Line 100
Page 80
Pattern 101
pop-up 17
pop-up, canceling 18
Text 97
Zoom 83
Merge (File Replace) 62

Merging two drawings 62,

114

Messy screen (redraw)
122

Metric grid spacings 56

Metric page grid, setting
80

Middle Align (Arrange)
42,96
Mirror (Edit) 87
Mouse Buttons (actions)
11
Moving
box 18
multiple objects 40
objects 114
cursor (text box) 111
Multi-level group 43
Multiple objects
aligning 41
effect of actions on 40
moving 40

Migraph Easy-Draw

working on 39

Normal (Text) 98

Normal (Zoom) 60, 85,
119

Normal zoom and text
editing 84

# Objects Available 74

o)

Object (definition) 11
Object Box (definition) 11
Objects
3-D look 116
actual size viewing 85
aligning 107
aligning multiple 41
arranging in layers 120
changing a group 45
changing group size 45
coloring 109
combining 32
copying 87, 109
copying a group 46
creating a group 43,
112

deleting 86, 112

deleting, reversal 112

deselecting 116

dissolving group 44

drawing 110

effect of actions on
multiple 40

erasing 112

erasing, reversal 112

exploding a group 95,
112

filling with pattern 101,
112

flipping 87

grouping 95, 112

grouping (exploding)
112
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hiding parts of 121
in Window 74
layer 120
moving 114
moving multiple 40
multi-level group 43
overlapping-
underlapping 94
polyline open/close 89
putting in front/back
115
resizing 67
rotating 88, 115
saving temporarily 112
selecting 116
selecting (unselect) 116
selecting all at once 83
separating 95
shadows on/off 102,
116
sizing 117
sketch open/close 89
squeezing 63
stretching 117
three-dimension look
116
transparent 118
undeleting 86, 112
unselecting 116
working on group 43
working on multiple 39
OK Button 75
Open #2 (File) 68,77, 114
Open (Edit) 89, 120
Options
reusing settings 53
setting default 53
saving settings 53
Outline (Text) 98
Output, starting 54
Output (File) 78, 115
Overlapping objects 94

Page grid
adjusting markings 55
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changing grid spacing
56

setting to inches 80
setting to metric 80
Page menu
Erase All 83
Grid Display on/off 56,
82

Grid Snap on/off 57,
82

Grid Spacing 56, 81
picture 80
Ruler Display 55, 81
Select All 83
Size 80
Page Size dialog box 81
PAT files 103
Pattern creation 110
Pattern filling of objects
112
Pattern menu
Load User Pattern 103
picture 101
Save User Pattern 103
Shadow 102
Styles 101
Transparent 101
User Pattern 102
Pattern Styles 112
Pattern Styles dialog box
19, 101
Patterns
changing 35
creating your own 36
dialog box 36
filling objects 35
loading 38
opaque 101
saving 37
see-through 101
styles 101
transparent 101
user created 102
using your own 37
working on 35
Pictures
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repeating screens Printer options, setting 52
(printing) 79 Printer requirements 13
time between (printing) Printing

‘Pie charts 122

Pie/Arc (Edit) 90

Pixels per line setting 75

Point mode, changing to
22,108

Point size (text) 99

Pointers 12

Polyline (definition) 12

Polyline (Edit) 91

Polyline open/close 89,
120

Pop-up menu (drawing)
canceling 18
illustration 17

Pop-up menus
(commands)
Center of Page

(Arrange) 97
Even Distance
(Arrange) 97

Flip (Edit) 87
Mirror (Edit) 88
Replace (File) 77

Portrait printing direction

Practices
- changing a pattern 19
changing box size 21
changing color 20

changing letter size 24
changing line width 20

drawing a box 17

any drawing 47

direction 80

drawings 115

editing a printing list 49

landscape direction
(sideways) 80

more about 47

on screen 48

Output command (File)
48,78

point size (text) 99

portrait direction
(upright) 80

printing drawings 115

printing list 48

reusing a printing list
51

reusing saved options
settings 53

saving a printing list 50

saving options settings

screen 79

screen repeats 79

setting default options

setting pixels per line
7

setting printer options
52

setting screen options

time between screens

filling a box with a 79
pattern 19 Printing a drawing 26
moving a box 18 Printing list
printing a drawing 26 editing 49
quitting Easy-Draw 27 reuse 51
saving a drawing 25 saving 50
writing text 23 Publishing, desktop 61

Previewing drawings on Put in Back (Arrange) 94,
page 85 115, 120

Printer Options dialog box Put in Front (Arrange) 94,
52 115, 120



Index

Quick print of screen 26,
75

Quit (File) 79, 115

Quit (Output File) 115

Quitting Easy-Draw 27,
79, 115

Recommendation, grid
spacing 82

Recommended grid
settings 57

Redrawing the screen 122

Reformatting text 111

Removing objects 86

Removing shadows from
objects 102

Repeating screens
(printing) 79

Replace (File) 62, 76, 114,
115

Replacing a drawing in
window 115

Resizing an object 67

Resizing, effect of grid
snap 82

Retrieving your patterns
103

Returning objects from
Trash 86

Reusing a printing list 51

Reusing saved options
settings 53

Reusing your patterns 103

Right Align (Arrange) 42,
96

Rotate (Edit) 88, 115
Rotating objects 88, 115
Rotating text (can't) 89
Rotating wedges 89
Rotation direction and
degrees 88
Rubber Band Box 12
Ruler
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adjusting 55

turning on/off 535
Ruler Display on/off

(Page) 55, 81, 110

Save (File) 77,118
Save As (File) 78, 118
Save User Pattern
(Pattern) 103
Saving
different name 78
drawing 25
printing list 50
drawings 118
objects temporarily 112
options settings 53
your patterns 37, 103
Screen
command 52
drawing 122
Easy-Draw start 106
irregularities (redraw)
122
mess (redraw) 122
Options dialog box 53
options, setting 52
printing 79
Scrolling a drawing 57,
116
Second window
activating 77
opening 68
See-through patterns 101
Select (definition) 12
Sclect All (Page) 67, 83
Selecting objects 116
Selecting objects (unselect)
116
Separating objects 95
Sctting colors 33
Setting default options 53
Setting metric page grid
0

Setting printer options 52
Setting screen options 52
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Settings, pixels per line 75

Settings (Color) 109

Settings, recommended
grid 57

Shadow (Edit) 116

Shadow (Pattern) 102

Shadowing objects, on/off
102, 116

Shapes of lines 100

Shrinking text block to fit
text 122

Sideways printing
(landscape) 80

Size (Page) 80

Size Mode (Edit) 89, 117

Size of text 99

Sizing and grid snap 89

Sizing, effect of 89

Sizing Marker (definition)
12

Sizing markers (Size) 89
Sizing markers (Stretch)
90

Sizing objects 117
Sketch
closing 120
editing 91
open/close 89
Spacing Center of Page
(Arrange) 96
Spacing Center of Page
pop-up menu 97
Spacing Even Distance
(Arrange) 97
Spacing Even Distance
pop-up menu 97
Spacing recommendation,
grid 82
Spacings, grid 56
Splitting a polyline or
sketch 92
Squares 120
Squeezing an object 63
Start Output (Output File)
115
Start Output dialog box 54

Migraph Easy-Draw

Starting Easy-Draw 15,
117

Starting Output 54

Stop editing text 111

Storing drawings 13

Stretch Mode (Edit) 64,
90, 117

Stretching and grid snap
90

Stretching, effect of 90
Stretching objects 117
Style, default (text) 100
Styles (Pattern) 101, 112
Styles (Text) 99

Styles of lines 100, 108
Swatches, color 104

Techniques

3-D look 116

adding text 111

adjusting the grid 107

adjusting wedges and
arcs 107

aligning objects 107

arc adjustment 107

ASCII file loading 111

breaking text blocks
111

canceling a command
108

canceling drawing 110

canceling text insertion
113

changing line width and
style 108

changing to point mode
108

choosing commands
108

choosing menus 108

coloring objects 109

command canceling
108

copying objects 109

creating a group 112



creating a pattern 110
cursor movement 111
deleting objects 112
deselecting objects 116
dialog box choices 108
displaying the ruler 110
draw canceling 110
drawing merging 114
drawing objects 110
drawing printing 115
drawing replacement
115
drawing saving 118
drawing scrolling 116
editing text 111
emptying Trash can 112
erasing objects 112
erasing objects, reversal
112
erasing text 111
exploding a group 112
file loading (ASCII)
111
filling objects with
pattern 112
grid adjustment 107
grouping objects 112
hard disk installation
124
inserting text 113
inserting text, canceling
113
installing Easy-Draw on
hard disk 124
labels, vertical text 118
line width and style
changes 108
loading ASCII files 111
merging drawings 114
moving objects 114
moving the cursor 111
object alignment 107
object coloring 109
object copying 109
object deletion 112
object deletion, reversal
112
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object deselection 116
object drawing 110
object erasure 112
object erasure, reversal
112
object filling, with
pattern 112
object movement 114
object rotation 115
object selection 116
object selection
(unselect) 116
object sizing 117
object stretching 117
object transparency 118
pattern creation 110
pattern filling of objects
112
point mode, changing to
108
printing drawings 115
putting objects in
front/back 115
quitting Easy-Draw 115
reformatting text 111
replacing a drawing in
window 115
rotating objects 115
ruler display 110
saving drawings 118
saving objects
temporarily 112
scrolling drawings 116
selecting objects 116
shadowing objects 116
sizing objects 117
starting Easy-Draw 117
stop editing text 111
stretching objects 117
style of line 108
text additions 111
text block breaking 111
text editing 111
text editing, stopping
111

text erasure 111
text insertion 113
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text insertion, canceling
113 _
text labels, vertical 118
text reformatting 111
three-dimension look
116
transparent objects 118
Trash can emptying 112
two windows 114
undeleting objects 112
unselecting objects 116
vertical text labels 118
wedge adjustment 107
width of line 108
window, drawing
merging 114
window, drawing
replacement 115
windows, using two 114
zooming 119
Temporarily saving objects
112
Text (Edit) 63,92
Text additions 111
Text and graphics grouping
121
Text block breaking (F10)
64, 111
Text blocks, fitting to text
122
Text choices
Bold 98
fonts 99
Height 99
Italic 98
Justify 99
Light 98
Normal 98
Outline 98
point size 99
Styles 99
turning all off 98
Underlined 98
Text editing 111
Text editing, normal zoom
84
Text editing, stopping 111

Migraph Easy-Draw

Text erasure 111
Text formatting
Bold 98
fonts 99
Height 99
Italic 98
Justify 99
Light 98
normal 98
Outline 98
point size 99
Styles 99
turning all off 98
Underlined 98
Text insertion 113
Text insertion, canceling
113
Text labels, vertical 118
Text menu
Bold 98
Height 99
Italic 98
Justify 99
Light 98
Normal 98
Outline 98
picture 97
Styles 99
Unavailable 1-4 100
Underlined 98
Text reformatting 111
Text rotation (can't) 89
Text Styles dialog box 99
Three-dimension look 116
Time between pictures
(printing) 79
Top Align (Arrange) 42,
96

Transparent (Pattern)
101, 118
Trash can 75
Trash can emptying 112
Turning grid display on/off
56

Turning grid snap on/off
57



Index

Turning off all text choices
98
Turning ruler on/off 55

Unavailable 1-4 (Text)
100
Undelete (Edit) 86, 112
Undeleting objects 86, 112
Underlapping objects 94
Underlined (Text) 98
Unifying objects 95
Unselecting objects 116
Upright printing (portrait)
80

User Pattern (Pattern)
102, 110

User Pattern dialog box
36, 103

User-defined patterns 101

Using your patterns again
103

Version Number 74
Vertical text labels 118
Viewing actual size 85

w

Wedge adjustments 107
Wedge rotation 89
Wedges (pie chart) 122

Width of line, changes 108

Windows

activating second 32, 77

combining objects with
two windows 32
copying between 32
opening second 68
Writing text 23

Z

143

Zoom
controlling size 84
how drawing expands

Zoom levels 58
Z.0om menu
Area 59, 83
Full Page 59, 85
Last 60, 85
Normal 60, 85
picture 83
Zoom Normal and text
editing 84
Zooming
drawing 58
area 59, 83
between two levels 60
techniques 119
to full page 59
to last view 60
to normal view 60
to views between levels
60
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INTRODUCTION

Supercharger is a product that allows you to convert paint and
scanned images, as well as portions of any screen, into standard
GEM bit-image format (.IMG). For those people who own the
bit-image enhanced version of EasyDraw, these images can then be
placed onto your EasyDraw page for use in newsletters, brochures
and more.

The Supercharger is powerful, yet easy to use. It consists of two
separate programs: an image converter and a snapshot utility. The
converter allows you to load and edit images, and save them in .IMG
format. The snapshot utility allows the capture of any screen from
your favourite application, which can then be loaded into the
converter for editing.

Once an image has been converted to .IMG format, it can then be
used with any application that loads .IMG files, such as EasyDraw.
We know that once you become familiar with the Supercharger you'll
discover many uses for the images which will enhance all your
projects.

What’s In This Manual

This manual is divided into two major parts: a section on using the
image converter and a section on the snapshot utility. This manual is
not meant to be read cover to cover, but used as needed. You'll find
a tutorial for using the converter. It is recommended that you go
through the tutorial first, and then refer to the manual as required.

Some Terms

The following terms and their definitions will help you to understand
the different parts of the Supercharger and how they will work.

Aspect Ratio: Aspect Ratio usually refers to the horizontal width
versus the vertical height of one pixel in an image or on an output
device (such as your monitor). Low-res colour and high-res mono-
chrome monitors on the ST have a ratio close to 1:1. We recommend
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running the converter in LOW or HIGH resolution when loading a
low-res or high-res picture (use medium-res when loading or editing a
medium-res picture) because of their near 1:1 ratio.

Bit-Image are paint images created on a dot by dot or pixel basis and
are usually screen resolution dependant. In other words, one dot on
the screen corresponds to one piece of information in the file. Most
paint images have a resolution of 75 dpi.

Scanned images originate from either line-art or half-tones which are
then optically read into the computer using a hardware device called
a scanner. These images can vary in resolution, or dots per inch,
depending on the sophistication of the scanning software. The
resolution of scanned images typically ranges from 75 to 300 dpi.

Digitised images are those which have been optically read into the
computer through a video scanner. The images are usually saved in
paint format.

Compressed bit-images are those which when stored, encode the
pixel information, rather than storing each dot separately. Com-
pressed and uncompressed images look the same on the screen, but
the compressed method of storage is preferable because the files
take up less disc space.

dpi: Abbreviation for Dots Per Inch, which describes the resolution of
a device or file. It is typically used by hardware manufacturers to
state the maximum level at which a monitor, printer, scanner, etc
operates. It is also used for the resolution of a particular graphics
image.

Mapping: Mapping has almost the same meaning as convert.
Basically it refers to changing graphic information from one form to
another. For instance, in the Supercharger, all colour pictures are
“mapped” to monochrome. That is, all colours are converted to a
shade of grey created by a pattern of black and white dots. Graphic
information is also mapped when viewing a picture at different screen
resolutions.



Memory: A hardware component inside your computer which is used
to store any information during the current program.Typically this
information is only stored while the computer is powered “ON". That's
why images saved with the Supercharger should be saved to disc for
permanent storage.

Pointer: The indicator on the screen that shows where where you are
on the drawing. The Supercharger has the following pointer shapes:

-|— Cross hair (drawing) pointer
%\., Finger (section) pointer
£ Open hand (move) pointer

Arrow (choice) pointer for menus,
commands, dialogue boxes, and
drawing tools

Resolution: The common definition of resolution refers to how many
pixels are contained per inch in either a vertical or horizontal
direction. It is also used sometimes to state the number of pixels
across the width or height of a device.

Scanner: A scanner is a piece of hardware that optically reads
information a computer, usually from line-art or photographs. This
information is then stored in a file which can be used with programs
like the Supercharger and EasyDraw to become part of newsletters,
reports etc.

Storing Images

You are advised against saving your images on your original
Supercharger disc. Instead, save your images on a blank, formatted
disc, or a disc which has a major portion still available for storage.



THE IMAGE CONVERTER

The image converter allows the loading of bit-images from Degas,
Degas Elite, Neochrome, MacPaint and .IMG files. Once loaded, they
can be edited and saved in monochrome GEM standard compressed
.IMG format. Because most paint programs have developed their file
formats for saving images, they must first be saved in .IMG format to
be used with Easy-Draw. The reason for this is that Easy-Draw was
developed according to GEM standards and so is only compatible
with GEM standard file formats.

This section on the converter is divided into five parts;

» A section describing bit-image files

» A tutorial on using the converter with paint images
« A section on techniques

* A section on scanned images

+ A summary of menu commands and tips

The best way way to become familiar with the converter is to go
through the tutorial using one of the sample images provided on the
disc.

Bit-lmage Files

On your disc there are several folders that contain samples of all the
types of bit-images that are supported. The first folder is entitled
“Paint” and contains the following picture formats:

+ Degas

filename.PI1 (low resolution)
filename.P12 (medium resolution)
filename.PI3 (high resolution)



* Degas Elite
filename.PC1 (low resolution)
filename.PC2 (medium resolution)
filename.PC3 (high resolution)

* Neochrome
filename.NEO (low resolution)

«  MACPAINT
filename.MAC (high resolution)

Bit-images in all three resolutions (low, medium, high) have been
provided for you. Previously, a bit-image could only be viewed at the
resolution in which it was created. For instance, you could only view a
low-res bit-image with a colour monitor set at low-res.

With the converter, however, you can load any bit-image, even those
created at a different screen resolution than what you are using. Most
paint images are created in colour so they can take advantage of the
many colours and shades available. When using the Supercharger,
all colours are automatically mapped to monochrome; i.e., each
colour is translated into a shade of grey, created by a pattern of black
and white dots. Even if you are using a colour monitor, your image
will appear in black and white. The reason for this is that for page
layout work, most affordable high resolution dot matrix and laser
printers print only in black. By showing the bit-image in black and
white, you'll get the best possible print out.

To be able to properly display the patterns while maintaining the
image’s integrity, the viewing area is also increased, The resolution of
the viewing area will vary, depending on whether the original
bit-image was in colour or black and white, and if in colour, which
method of mapping was chosen.

When loading a colour bit-image, a dialogue will appear that asks you
to choose a method for mapping the image. Each method offers a
different way handling the colours of the picture and the dot ratio.
Your picture will look better or worse, depending on which method
you choose. It is mostly by trial and error that you'll find which you
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prefer for different bit-images. for more detailed explanation of how
this dialogue box works, follow the tutorial and read the section on
techniques.

Tutorial

This section contains a short walk-through lesson to make you
familiar with the basic techniques for using the converter. When
you're done, you should know enough about using the converter to
explore it fully and easily. Please note that although this tutorial
covers using both colour and monochrome monitors, the illustrations
in this section were done with a monochrome monitor. This section
covers the following topics:

 Starting the converter

* How to load a monochrome and colour bit-image

* How to view an image

* How to edit an image

* How to clip, or select an area of an image

* How to save a .IMG file

* How to quit the Supercharger

Starting the Supercharger

To start the tutorial on the Supercharger from the floppy disc, follow
these instructions:

1 Insert the Supercharger disc in drive A.

2 Turn on your Atari ST. If your are using a colour monitor please
set it to low resolution.

3 When a window appears with a list of the files, move the mouse
until the arrow rests on the name "SCHARGER.PRG".

4 Double click the left mouse button.




The Supercharger wil start and you will see the following screen:

' Loading a Bit-lmage
In this section you will load a monochrome and colour bit-image.
To load a monochrome bit-image, follow these instructions:

1 Point to the File menu. The menu drops down and shows five
formats: DEGAS, DEGAS ELITE, .IMG, MACPAINT, and
Neochrome.

2 Point to .IMG and click the left mouse button. A File Selector Box
will appear.

3 Point to the folder “IMAGES.IMG” and click the left mous button.
The folder will open showing the files listed in it.

4 Click on TIGER.IMG.
5 Click on OK.



The bit-image will appear as follows:
Desk File View Edit

Normally, you would begin to view the image and edit it if necessary,
but because most times you'll want to load a colour bit-image, we’'ll
go through those steps.

Loading a Colour Bit-Image

1

3
4

Point to the File menu and click on DEGAS. A File Selector Box
will appear.

Point to folder “PAINT” and click on the left mouse button. The
folder will open showing the files listed in it.

Click on BEE.PI1.
Click on OK.

A mapping dialogue box will appear so you can select a method for
mapping the bit-image.

_COLORS TO BLACK
AUTO-HAPPING  7x2
[ AUTO-HAPPING _4x4 |
[ TRBLE-MAPPING 4x4 ]




Colors to Black

This method offers three choices for turning all colours, except
. white, into solid black.

Auto-Mapping 2x2

This method maps each pixel in the original image to a 2x2 matrix,
and assigns each colour a black and white pattern.

Auto-Mapping 4x4

This method maps each pixel in the original image to a 4x4 matrix,
and assigns each colour a bick and white pattern.

Table-Mapping 4x4

This method provides you with a table so you can set the pattern
for each colour yourself.

5 Click on Map to Black
An alert box will appear, as follows:

Hap all, most, or some

' v colors to black?

All | | Most Some

6 Click on Some:
Your screen will look like this:




Now you'll reload that same image, but mapped with a different
method.

1 Follow steps 1-4 from above.
2 This time select Auto-Mapping 2x2.
Your image will now look like this:

Notice the difference with the patterns. This method offers greater
detail without taking up a lot of disk space when saving the image.

Viewing an Image

Now that you've loaded a bit-image, you'll want to experiment with
viewing it. Scroll bars are provided to the right and bottom of the
image window so that you may view all portions of the image.

Simply move the arrow onto the white slider area, and holding the left
mouse button down, move the bar, then release the mouse button.
The area you've selected will now appear in your window.

To see what the whole image looks like:
* Go up under VIEW and click on Open Full ,a window will now
appear to the right, showing the full image from top to bottom.

To view the image from left to right:
*  Move the scroll bar at the bottom of that window.

To make this window the size of the screen:
« Click on the full box in the upper right corner.

10



To close the window:
* Go up under VIEW again, and click on the Close View

Z0R=
’ Click on the close box in the upper left corner of the FULL
window.

Note: Changes made in the image window are not reflected
automatically in the Full window. You must close the window
and reopen it to view them.

Now try the different zoom levels.

» Go up and click on 2x.Your image will now appear twice as large
as the original. Notice how the white area on the screen bars has
decreased. Because the image is now larger, you are able to
view less of it at a time.

» Click on 4x and see the differences in the image. It will be four
times the size of the original.

* Now go back to zoom normal.

. Editing an Image

Tools are provided so that you can edit images on a pixel/dot basis.
To edit an image, follow these directions:

1 Point to the Edit menu.The Edit menu drops down and displays
these choices: PEN, INVERT IMAGE, NEW IMAGE.

2 Click on Pen with the left mouse button.Your pointing arrow has
now become a cross hair pointer.

3 Press the left mouse button and holding it down, move the mouse
slowly. It will leave black dots wherever you have moved the
mouse.

4 To create one dot, simply press and release the left mouse button
without moving the mouse.

Feel free to experiment with the pen, and do some freehand
sketching. Four different pen widths are provided. F1 being the
. narrowest and F4 the widest.

T



To change from one width top another:
* Press the function key for the width you want before you begin to
edit.

To change the pen from black to white: .
» Hold the shift key down while editing.

Note: While you can edit an image and in fact create new ones with
the pen command, the Supercharger was not intended to be
a paint program.

When you have finished editing:
» Go up under Edit and click on REDISPLAY. Your cursor will now
return to the arrow shape.

The converter also provides a way to invert or reverse the image.

To invert the image:

« Point to the Edit menu and click on INVERT. Your image will now
invert: What was black before will now be white, what was white
will now be black.

Often an image that you have loaded will look better when inverted.
* Invert the current image, and then invert it back to the original. ‘

Clipping an Image

Often after you have loaded an image and edited it, you'll want to
save only a portion for later use.

To clip or select a portion of an image, follow these directions:
1 Point to the Edit menu.
2 Click on Define. Your pointer will now turn into the finger pointer.

3 Move the hand to the upper left corner of the portion of the image
that you want to select.

4 Holding the left mouse button down, drag the mouse until the box
is the size of the area you want.

5 Release the mouse button.
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A white, wire-frame box, called the clipping box, will now be on your

screen. o -
o1] i3]
5— = €1

You can edit and move this box. For further information on this, see
the section on Techniques.

Saving an Image

When you are ready to save an image, there are two choices under
the File menu: Save CLIP IMG and Save FULL IMG. One allows you
to save a portion of the image (the portion that is in the clipping box),
while the other saves the whole image.

Note: Single disc drive owners must place a disc in drive A before
saving images. Dual drive owners should already have their
disc in drive B.

To save a portion of an image, follow these directions:

1 Choose Save CLIP IMG from the File Menu. The File Selector
box appears like this:

ITEM SELECTOR

Directory:
Ai\¥, IMG.

. | Selection:
SAMPLE| .-
ALERT .IMG

ARRON .G
CROSHAIR , MG
DTALOGUE. 1HG
FILE  .IMG o]
FRAME  .IMG
HAND  .IMG

MAPPING .IMG
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2 Type the name of your image, such as:
SAMPLE
The Supercharger uses this name to identify the image for you so ‘
that you can use it later. the name can have up to eight letters in

any order . The file extension of .IMG will be loaded
automatically.

3 Point to the box with OK inside it, and then click the left mouse
button. The Supercharger saves your image on the disc in a file
named SAMPLE.IMG.

Note: The default drive to save your image is the drive that the
Supercharger was started from.

To change the disc drive:
» Edit the line under “Directory” in the File Selector box.

For example, to save to drive B:

1 Move the mouse pointer to the Path name and click.

2 Then, using the left arrow key, go back to A:

3 Backspace over A, and type in B. .
4

Move the mouse pointer above the first file name, and click the
left mouse button.

To save a full image, you would follow the previous directions, but
choose SAVE FULL .IMG instead of SAVE CLIP .IMG

Quitting the Supercharger

When you have finished and want to shut off the Supercharger, follow
these directions:

1 Choose QUIT from the file menu. When you choose quit, it will
ask you if you really want to do this. If you have not saved your
image yet, and want to, click on cancel. Save your image, and
then quit.

2 When a dialogue box appears, Click the answer that suits you.
The Supercharger will obey your wishes, and then quit. You'll see ‘
the GEM desktop again. Only at this point is it safe to remove
your disc from the drive.
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Summary of the Supercharger Tutorial

The following list will remind you of the directions and techniques you

practiced in this section of this manual.

« How to start the supercharger by double-clicking on the name
SCHARGER.PRG.

* How to load a monochrome bit-image by choosing a name from
the File Selector box.

» How to load a colour bit-image using two mapping techniques.

« How to view an image at different zoom levels by clicking on
Normal, 2x and 4x from the VIEW menu.

« How to view a full image by clicking on Open Full from the VIEW
menu.

« How to edit an image dot by dot: by clicking on Pen ON, by
pressing on the left mouse button while moving the mouse to add
black lines or dots and by varying the widths with function keys
F1-F4.

» How to invert an image by clicking on Invert under the EDIT
menu.

« How to create a clipping box to select a portion of an image by
clicking on Define from the EDIT, and while pressing on the left
mouse button, dragging the mouse to form a box around the area
you want selected.

+ How to save and name an image.

+ How to quit the Supercharger.

At this point you should just start the Supercharger again and explore
the various tools and commands. Just try it out; you cannot damage
the program or your computer while exploring the Supercharger.

If you want to feel a little more confident before jumping in, why not
go through the exercises in this section again. If you want to learn
more about the menus and their respective commands first, go to the
section on the menus. It contains a detailed description of each
command.

When you are ready to load a picture onto your own Easy-Draw
page, go to the Easy-Draw Addendum. You'll find that it is fun and
easy to add bit-mapped and scanned images to your pages!
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Techniques

This section provides a more detailed description of different .
commands and features found in the Supercharger. 4

This section contains the following topics;

* Information on colour paint files.

» Mapping choices: Map to Black, Auto-Mapping 2x2, Auto-
Mapping 4x4, Table-Mapping 4x4.

» Clipping an image.

» Saving an image.

* Printing an image.

Loading a Colour Paint File

This section gives you more detailed information that you will find
helpful when loading colour paint images.

When loading a colour paint file into the converter, colours are
mapped to monochrome using patterns of black and white. A ‘
dialogue box will appear which asks you to select a method for
mapping the colours. There are four choices, each of which will affect

the image in a different way. Although we make recommendations,

the individual picture and your equipment configuration will help
determine which method you prefer for mapping various bit-images.

The methods are listed in order, top to bottom, from the one that
converts images the most quickly (Map to Black) to the most slowly
(Table-Mapping 4x4). The first method is the fastest because the
images are mapped to pure black and white. The last has many
patterns. The more mapping the converter has to do, the longer it
takes to convert an image. We recommend using the first method,
Map to Black, to preview your images, especially if you've never seen
them before. It is the fastest loading and enables you to view many
images quickly.

Even more important is how much disk space an image takes when
saved. Those images with fewer patterns take the least amount of ‘
disk space, while those loaded with 4x4 take the most. Because full
screen images loaded with 4x4 can take up so much memory, up to
130K or more, it is recommended that you save only portions of the
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image, otherwise you may run out if room on the disc when you try to
save an image, or in your computer when you try to use the images
with Easy-Draw.

When selecting a mapping method, it is important to consider what
you want the final printed image to look like. Do you want it to be
large, small, with great detail, or with little detail? Several factors
besides the mapping method will influence how the final printed
image will look, including:

* The printer’s resolution

+ The size and complexity of the image

* The desired size of the final image

Each of these factors must be looked at and taken into consideration.
For instance, if you have an .IMG file saved with 4x4 patterns, and
you want to print it using a 9-pin dot matrix printer that has a
resolution of 120x144, the printer will “drop” pixels because the
image has a greater resolution than. the printer can print. What
happens is that the printer figures a mathematical solution and may
“drop”, or not print certain pixels.

The same thing will happen if you have a large original image that
you want to reduce to a smaller area. It all depends on how many
pixels are in the image, and how many pixels your printer is capable
of printing.

Or, perhaps you have the opposite suituation where you want to print
a low-res bit-image on a 300 DPI laser printer. The printer has a
higher resolution than the image, and so will add pixels to it. The
same will occur when a small original image is enlarged to fit the big
area.

Likewise, the complexity of the image must be considered. A simple
image, with few patterns, will look better reduced than a complex
image with many patterns.

In general, if you have a 9 or 24 pin printer, you'll want to use the first
two methods, Map to black or Auto-Mapping 2x2. Use the last two,
Auto-Mapping 4x4 and Table-Mapping 4x4, if you have a laser printer
as well as a large amount of memory in your computer, or when you
plan on saving out a small portion of the image using a clipping box.
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Mapping Choices

This section provides an in-depth look at the four mapping choices
and the effects they have on colour images. .

COLORS TO BLACK

AUTO-HAPPING _dxd

TABLE-HAPPING 4X4_

Colors to Black

Recommended for previewing paint images, black and white digitised
images saved in paint format, and for images with few colours. Can .
be used satisfactorily for many medium-res pictures.

When this method is chosen an additional alert box will appear that
looks like this:

Map all, most, or some

v colors to black?

[ Al || Most | | Some |

It offers you three choices:

ALL This choice automatically turns all coloured areas of the original '
image to solid black, while keeping all the white areas solid white.
The result is a harsh looking image that may not resemble the

18



SOME This choice offers the least radical treatment of the colours.
Only the dark colours (those that are over 70% black) are mapped to
solid black, while the rest are mapped to white. This is the method we
recommend for previewing images.

The image will look different, depending on which of these you
choose. Remember that because all or most of the previous colours
are now black, you will lose a lot of detail and depth in the image,
which colours normally create. One of the advantages of the Map to
Black method is that when the images are saved, they take up the
least amount of disc space.

Auto-Mapping 2x2

Recommended for paint images that have several colours, and
coloured, digitised images.

With this method, a pixel in the original image is converted into a 2x2
matrix or four pixels of information. For example, a 320x200 low-res
colour picture will be mapped into a 640x 400 .IMG file, while a
640x200 medium res colour picture will be mapped to 1280x400.

As the original colour paint file is loaded, the converter will check
what colours are in the image, sort the colours from light to dark, and
assign an appropriate 2x2 pattern for each other, it will try not to
assign the same pattern to each area.

For most paint pictures, this will be the standard method to use if
detail is lost using the first method.

Auto-Mapping 4x4

Recommended for low-res images with many colours.

When an image is loaded into the converter with this method, each
pixel in the original is mapped to a 4x4 matrix, or 16 pixels. In other

words, if the original was a low-res full screen colour image, 320x200,
it would be mapped to 1280x800.

As the original colour paint file loaded, the converter will check what
colours are in the image, sort the colours from light to dark, and
assign an appropriate 4x4 pattern for each dot. Also, when two dark
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areas are close to each other, it will try to assign the same pattern to
each area.

Remember that this method will potentially produce a very large .IMG

file when saved, so it should only be used for saving small portions of

the original image, or if your system has 2MB or more of memory.

Note: If you have a monochrome monitor, you should always select
Auto-Mapping instead of Table-Mapping, since you will be
unable to preview the colours of the original image.

Table-Mapping 4x4

Recommended for low-res images when you need to control the
patterns yourself.

This method should be used with the monitor set to low-res, and is
essentially the same as the Auto 4x4, except you have the option of
setting the patterns yourself. When you select this method, another
dialogue box will appear that looks like this:
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It is the table of colours and patterns. To use this dialogue box, follow
these directions:

1 Note the colours and corresponding patterns. The colours you
see here are the ones selected by the original artist.

2 Click on AUTO. The converter will now sort the colours from light
to dark and assign an appropriate pattern to each colour. The
table will now reflect this. This step enables you to see what the
converter would pick for each colour.

3 Click on any colour you would like to change and then click on the
pattern below that you would like to change it to.

By previewing the original colours first, coupled with what the
converter would have chosen, it allows you to make a better choice if
you feel the need to alter any of the patterns.

Remember, like the Auto 4x4, this method will produce a potentially
very large .IMG file when saved, so it should be used for saving small
portions of the image, or if your system has 2MB or more of memory.
We highly recommend experimenting by printing different resolution
images that have been loaded with of the mapping techniques. In a
short time you'll find what works for you and suits your needs.

Clipping an image

Clipping an image means selecting a portion of it to save out for later
use. The portion you want is selected with a white box called the
clipping box. You can create clipping box when an image is first
loaded, before doing anything else.

To create a clipping box, follow these directions:

1 Move the pointing finger to the upper left corner of the portion of
the image you want to save.

2 Holding the left mouse button down, drag the mouse until the box
is the size of the area you want.

3 Release the mouse button.

The clipping box will now be on your screen with smaller boxes
along the outline of it. These smaller boxes are called
polymarkers.
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When you wish to edit the shape of the clipping box, follow these
directions:

1 Decide how you would like to change the shape of the box.

2 Chose the appropriate polymarker by placing the finger pointer in
it. :

3 Hold down the left mouse button, and then move the mouse,
either to expand or shrink the box.

To move the clipping box:
1 Move the finger pointer so that it is in the middle of the box.
2 Press the left mouse button until a hand pointer appears.

3 Sitill pressing the left mouse button, move the box to the area you
want.

4 Release the button.

Anytime you use the PEN or NEW IMAGE commands, the clipping
box will temporarily disappear from your screen. To make it visible,
choose REDISPLAY from the View drop down menu.

There will be time when you find it necessary to create a new clipping

box:

» If one was not created when the image was first loaded.

» When the image is very large and, rather than move the box to a
new area, you want to create a new one.

Note: When a new box is created, the previous one will be
eliminated.

To create a new clipping box:
e Use the DEFINE command, and draw a new box following the
same directions as above.

Anytime you want to know the size of your image and the size and
location of the clipping box, choose SHOW SIZE from the View
menu. A dialogue box will appear that shows the current values.
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IMAGE: WIDTH 648 HEIGHT 488

CLIP: X 23 Y 123
WIDTH 168 HEIGHT 146

CInfor ti1on 1n Pixcls)

PIXEL: WIDTH 318 HEIGHT 318

Microns) tMicronsy

« Click on OK or press the return key to remove the dialogue box.

To save a portion of an image, refer to the Tutorial or SAVE CLIP
.IMG in the Commands section of this manual.

Saving an Image

Whether you use the SAVE CLIP or SAVE FULL options from the

File drop down menu, you should record certain information about the

bit-image for use later in Easy Draw.

+ Size of full image or clipping area when saved out of the
converter (found in the Show Size dialogue box).

» Original resolution of the image if the image was scanned.

Printing an Image

Sometimes you will want to print out the .IMG files you have saved,
before you load them into Easy Draw. For this reason the converter
saves a small .GEM file along with each .IMG file. While this file
contains enough information for OUTPRINT.PRG to print the image
file, do not load this .GEM file into Easy Draw. To print an .IMG file,
you will run the Outprint program from the desktop level after first
booting with your Easy Draw disk.
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To print an image, follow these directions:
1 Insert the Easy Draw disc containing the OUTPRINT.PRG into

drive A '
2 Double click on OUTPRINT.PRG
3 Choose printer from the Options menu. A new dialogue box will

appear.

4 Set the Justification to “Top” and “Left”.

5 Choose Add Name from the Edit menu to add picture name(s) to
the print list. The File Selector box appears.

6 Type or choose the (.GEM) name of the pictures you want to
print.

7 Choose Start Outprint from the File menu. The Start Outprint
dialogue box appears.

8 Click on printer.
9 Click on OK to start printing

When printing is finished, choose Quit from the File menu to quit
printing and return to the desktop. .

Note: An .IMG file that is printed through Outprint may not look as
good as one that was sized in Easy Draw. This has to do with
the image’s resolution and the resolution of your printer. For
further information regarding this and using Outprint, refer to
the Easy Draw Addendum.

Scanned Images

Scanned images differ in a number of ways from paint images.
Foremost is that the original art was probably not computer
generated, but came from line art or a photograph (halftone). The
Supercharger supports only those scanned images saved in GEM
standard .IMG format. Because they are already in .IMG format, all
the mapping decisions that you previously had to make when loading
a colour bit-image are no longer necessary. .
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When you are at the desktop level, before you run the Supercharger,
take a quick look at the file size of the scanned images you intend to
use and jot them down. .IMG files can be potentially very large,and
depending on how much memory you have in your computer, you
may run into problems loading them into the converter.

Also, when you are not sure whether the scanned image is
compressed or not, you can tell after saving it out through the
converter, by comparing the before and after file sizes. If the file size
is smaller, then the original was compressed. If the file size is the
same, then the original was not compressed.

Once you are in the converter, to load a scanned image, follow these
directions:

1 Go up under Edit and click on LOAD .IMG. A File Selector box

will appear.
2 Click on the .IMG file that you wish to load.
3 Click on OK ;

For further information on loading files, see the Tutorial.

Once an image has been loaded you can view, edit, invert it, save it,
etc just like any other image. The same considerations that applied to
bit-images with regards to image complexity, resolution, and your
printer's resolution, still apply. Please refer to the “Techniques”
section of this manual for further information on this subject.

Scanners

Scanned images typically have a resolution ranging from 75 DPI to
300 DPI. The higher the resolution, the sharper the image. One of the
major advantages of having access to a scanner is that existing line
art and photographs can be quickly and easily scanned for use in
reports, newsletters, brochures, etc.

Different scanners are available on the market that will save images
out in GEM standard .IMG format. Here is the information on two of
them.

The Navarone scanner uses a Canon IX-12 scanner with their own
interface and software. This scanner can scan and save out images
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and horizontal resolutions are always the same. This scanner will
hook up directly to an Atari, so if you're looking for a scanner to scan
your own materials, this one will work.

Another scanner, the HP Scanjet, is a flatbed scanner of a more
recent technology and is capable of scanning images at mixed
resolutions, such as 120x144 (9-pin printer resolution). The benefit of
this is that you can scan images exactly tuned to the resolution of
your printer. Your print out will look exactly like the scanned image,
and you avoid the problem of your printer “dropping” or adding dots
to correct the resolution. Currently, to use this scanner, you need to
scan your material on an IBM computer, and then transfer the images
to your ST.

Summaries

This section provides a quick summary for easy reference of Migraph
Supercharger commands and some tips for using the Supercharger
more effectively.

Menu Commands

The description of the commands appear in the order they appear in
the menus. Directions for using the commands appear in this section,
and in the chapters entitled “Techniques”.

Note: Commands that display * followed by a letter offer keyboard
shortcuts for the experienced user. The * symbol means, hold
down the Alternate key and press the letter key.

Desk Menu

SuperCharger info..

NAR DAL DS BRE DL DBE BN DNE N R DS N BNE BN AP BN NP NS DN AN

Snapshot

SuperCharger info [Desk]
Use Supercharger Info to see the version number.
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Snapshot [Desk]

This desk accessory allows the capture and saving of screen images
from Gem applications. For a description of how the Snapshot utility
works, see the section of this manual entitled “Snapshot Utility”.

File Menu
ITEM SELECTOR
Directory:
e j ] wiae a \IMaGES IMG\¥, %
gegas El Selecti
i ; election:
g £ BASKETBD., GEM
MacPaint AMAZING .GEM
acPain AMAZING . IMG
NEOchrome
pran: Coye =wer ggéxersn.érgg
Clip (.IMB) '
Full (,IHG) LA
““““““““““““““ COFFEE . IMG
Ouit CONGRATZ ., GEM
Load [File]

Use Load to load an image created and stored in that particular
format. The formats are the ones currently supported by the
Supercharger. When you choose one of these, the Supercharger
displays the File Selector box to ask you for the name of the image
you wish to load. See “Hints” for information about using more than
one disc drive.

Save Clip (.IMG) [File]

Use SAVE CLIP .IMG to save a portion of the image that you have
selected using a clipping box. To save your image, type a name for
your image in the File Selector box (see the description of the file
menu for the printer of the file selector box). Include disc drive and
pathname information if you want to store the image on a different
disc drive or directory.
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When you wish to save a portion of an image, follow these directions:

1
2

Define a clipping box if you have not already done so.

Choose SAVE CLIP IMG from the File menu. The File Selector
box appears.

Type a name for your image, such as:
SAMPLE

The Supercharger uses this name to identify the image for you so
that you can use it later. The name can have up to eight letters
and numbers in any order. The file extension of .IMG will be
added automatically.

Point to the box with OK inside it, then click on the left mouse
button. The Supercharger saves your image on the disk in a file
named SAMPLE.IMG. At the same time, another file,
SAMPLE.GEM is automatically saved, which is used for printing
your bit-image.

Note: Single disk drive owners must place a disk in drive A before

saving images. Dual drive owners should already have their
disk in either drive.

Note: The default drive to save your image is the drive that the

Supercharger was started from.

To change the disk drive:

Edit the line under “Directory” in the File Selector box.

For example, to save to drive B:

A H ON =

Move the mouse pointer to the pathname and click.
Using the left arrow key, go back to A..

Backspace over A, and type in B.

Move the mouse pointer to the list of names

Move the mouse pointer to the white area just above or to the left
of the top name.

Save Full (.IMG) [File]

Use SAVE FULL IMG to save the whole image that you currently
have loaded in the converter. To save your image, type a name for
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your image in the File Selector box (see the description of the File
menu for a picture of the File Selector box). Include disk drive and
pathname information if you want to store the image on a different
disk drive or directory.

Quit [File]

Use QUIT to quit the Supercharger. The Supercharger will ask you if
you wish to quit. If you have not saved your image, and wish to,
choose Cancel, and save your image. Once you say OK to quit, the
Supercharger will return to the GEM desktop.

View Menu

Edit ‘

Open Full #&F
"""""" T e
v Normal i1
2% 2
dx 4
~~~~~~ AR S
Define )}
Redisplay R
Show Size.., &S

Open/Close Full [View] *F

Use OPEN FULL to view the full image. The window will compress
the image so that you can view it from top to bottom. The aspect ratio
of your monitor and your original image will taken will be taken into
account. Use the scroll bars to view the image from left to right, or
click on the full window box in the upper right of the full image
window to display the full width.
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Use CLOSE FULL or click on the close window box in the upper left
corner of the full window to close the viewing window.

Note: The Supercharger corrects the image to maintain the aspect
ratio of the image as well as the screen.

ZOOM NORMAL [VIEW] *1

Use ZOOM NORMAL to return to the normal size of your image after
having chosen either ZOOM 2X or ZOOM 4X.

At zoom normal, one pixel on the screen is equivalent to one pixel in
the original image.

ZOOM 2X [VIEW] *2
Use ZOOM 2X to enlarge the image to twice the normal size.

ZOOM 4X [VIEW] *4
Use ZOOM 4X to enlarge the image to four times the normal size.

CLIP DEFINE [VIEW] *D

Use DEFINE to create a clipping box that will enclose a portion of the
image that you wish to save. Unless you created a clipping box when
you first loaded an image, you must use DEFINE to create a clipping
box prior to saving a portion of the image.

To create a clipping box:
1 Point to the edit menu.
2 Click on define. Your pointer will now turn into the finger pointer .

3 Move the hand to the upper left corner of the portion you want to
save.

4 Holding down the left mouse button, drag the mouse until the box
is the size of the area you want to save.

5 Release the mouse button.

30



Clip Redisplay [View] *R

Use REDISPLAY to show the clipping box after using the Pen
command. Your clipping box MUST be displayed to be able to use
SAVE CLIP IMG.

Show Size [View] *S

IMAGE: WIDTH 648  HEIGHT 488

CLIP: 323 Y 123
WIDTH 168 HEIGHT 146

(Information in Pixcls)

PIXEL: WIDTH I18  HEIGHT 318

Use SHOW SIZE when you want to know the exact location and size
of your clipping box. It also gives you the size of the image file (how
many pixels) plus the exact size of each pixel. This information is
helpful, for instance, when you want to separate an image into
several exact pieces, like a puzzle.

Edit Menu

Invert Image %I
Clear Image %C
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Pen [Edit] *P

Use PEN when you want to edit an image pixel by pixel. There are
four different line widths, controlled by the function keys F1-F4. F1 is
the narrowest line and F4 is the thickest.

To edit an image follow these directions:

1 Point to the edit menu. The edit menu drops down and displays
these choices: PEN, INVERT IMAGE, NEW IMAGE.

2 Click on PEN with the left mouse button. Your pointing arrow has
now become a cross-hair pointer.

3 Press the left mouse button and, while holding it down, move
mouse slowly. It will draw a black line wherever you move the
mouse.

4 To create a dot, simply press and release the left mouse button
without moving the mouse.

To stop editing. click on REDISPLAY under the View menu.

Invert Image [Edit] *1

Use INVERT IMAGE when you want to invert the image. All areas
that were previously black will now be white, and all areas that were
white will now be black.

Choose INVERT IMAGE again to return the image to the original.

Clear Image [Edit] *C

Use NEW IMAGE to clear the screen of the current image. The
resolution of the cleared screen is 640x800 and can be used for new
images created with the PEN command.

Tips
Keep a Log of Images. It is important to keep a log containing the

names of the images and other statistics, such as height and width in
pixels. Below is a sample log.
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Name Source  Orig Res Size(WxH) Note
STIGER.IMG Scanner 150DPI 996x1498 Full Tiger
CLIPTIGR.IMG Converter 150DPI  900x600 Clipped Tiger

This size information is important because it will help you produce
better print outs when using Easy-Draw. By noting the bit-image
information plus your printer's resolution, you can “fine tune” the
bit-image and its corresponding box in Easy-Draw.

With the above example, if you are printing with a 300 DPI laser
printer and want a final print out to be mapped exactly into a 3" wide
by 2" high area, you would save out a clipping-box area of exactly
900 by 600 pixels, from the converter (for example, CLIPTIGR.IMG).

Remember: You can press Alternate-S to display the Show Size
dialogue box while in the converter.

Distorted Images

Whenever a large scanned image has been loaded into the converter
and appears distorted, it may be because of insufficient free memory
available. One reason this may happen is that the operating system
does not always reallocate portions of memory correctly after running
several applications.

If reloading the image a second time does not fix the screen display,
try one of the following:

. Quit the converter, start it again, and load the image.

. Reboot the system, start the converter, and load the image.

Make it a habit to view the images after loading them before making
any significant changes and saving your work. Do this by using the
slider bars to pan around the full image.
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SNAPSHOT UTILITY

Snapshot is a GEM Desktop accessory supplied with the Superchar-
ger that allows the capture and saving of screens (snapshots) from
your favourite GEM applications. These snapshots are saved in GEM
standard .IMG or DEGAS format and can be loaded directly into the
converter for editing, and then onto your Easy Draw page.

With this accessory you can capture the charts, picture, graphs, etc.
that you need to highlight newsletters, reports, brochures and more.

Installing Snapshot

Because Snapshot is a desktop accessory, it'must be installed on
your boot up disc (the disc you start your computer with).

To install Snapshot, follow these directions:

1 Copy the file SNAPSHOT.ACC onto the disc you normally turn
your computer on with.

2 Turn the computer off, wait 10 seconds, and then turn on the
computer.

3 Go up under DESK and find Snapshot installed.

Note: Easy Draw owners should install Snapshot on their Master
disc. Single-sided owners will have to remove the fonts which
they do not use (either the colour or monochrome) to make
room for this accessory.

Hard disc owners: install Snapshot on your hard disc boot up floppy
disc.

Using Snapshot

To use Snapshot while in any GEM application, follow these
directions:

Note: Monochrome owners should always save their screens in
.IMG format; however, should you choose to save screens in
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Degas format you must load them into the converter and
resave them in .IMG format before loading them into Easy
Draw. Colour owners MUST save their screens in Degas
format, load them into the converter and resave them in .IMG
format. Although Snapshot offers .IMG format to colours
users, it saves in colour .IMG format which is not supported
by Easy Draw at this time.

Go under the Desk menu and click on Snapshot. An alert box will
appear that looks like this:

SHAPSHOT™ V1,00
Screen Capture Utility
Copyright @ 1987,1988
Migraph, Inc.
A1l Rights Reserved,

IMG | [ Degas | [CANCEL|

It offers you these choices:

IMG - Click on this box to save a portion of the screen in .IMG
format.

Degas - Click on this box to save a portion of the screen in
Degas format.

Cancel - Click on this box to cancel the transaction.

Click on Degas. Your mouse pointer will now turn into a crosshair
cursor.

Move the mouse to the top left-hand corner of the area you wish
to capture.

Holding the left mouse button down, drag the mouse until the box
is the size of the area you want to capture. Your snapshot will
appear in reverse video, and then a File Selector box will appear.

35



5 At this point you can either enter a filename for the snapshot and
click on OK, which saves the snapshot. OR

Click on cancel, which cancels the snapshot. Your snapshot will
now be saved in Degas format. For monochrome users, should
you wish to save the snapshot in .IMG format, choose .IMG in
step 3 above, instead of Degas.

For more information on using the File Selector box, see the section
on saving images in the converter tutorial.

Tips

Once you have captured and saved a snapshot, you should always
load it into the converter for viewing. There you can edit it a pixel at a
time, and resave part or all of the snapshot for use in Easy Draw.
One advantage of saving snapshots in Degas format is that they can
be enlarged in the converter by loading them using the Auto-Mapping
2x2 option. This enlarges the image, making it easier to edit on a
pixel basis.

Many times you will have a snapshot in Degas format that is smaller
than a full screen. When a small snapshot is loaded into the
converter, always use the Save Clip IMG command to save it, after
selecting the image area with the clipping box. The reason for this is
that even though the image is small, if you use Save Full Image, It
will save the whole screen (the image plus the white area), so that
when it is loaded into Easy Draw, the image plus the white area will
appear.

Images saved in, .IMG format with the snapshot utility are un-
compressed. Load the files into the converter and resave them.

This saves them to compressed format which will take up less space
on the disk.

To capture zoomed-in or enlarged portions of objects in Easy Draw,
use the Snapshot Utility while zoomed-in in Easy Draw. Because
Easy Draw always prints out at Zoom Normal, the Snapshot Ultility
provides a way to capture close-up details. Be sure to load snapshots
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into the converter and resave them out. Then, print the .IMG file
directly through OUTPRINT or reload into Easy Draw for placement
on a page.
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~ Atlast! You can satisfy that creative urge to do your own artwork even if
. you can't draw a straight line with paper and pencil.
~ Now there’s Migraph Easy-Draw?® the object-oriented drawing program that
makes it easy for anyone to create professional-looking line drawings, technical
illustrations, and reports with a personal computer. V
Easy-Draw is fast, flexible and just plain fun to use. With it you can: create The Professional
complex illustrations, floor plans, landscape designs, etc. By using both the text Drawing Program
~ and graphics features you have a simple desktop publishing system that can be for the AtariST
_ used to create: newsletters brochures, presentation aids, forms, ads, ﬂyers, and . ~ -
much more. . Easy-Draw has

Desk File Page Zoom Edit Arrange Text Line Pattern Color . Desk File Page Zoom Edit Arrang: xt_Line Pattern Color '
~ re

T - SAHPLE.GEH o _PISTONEW,GEN — featllres: .
Easy — Draw: H » | {/ ) / //J/[/"r‘w = Pop-up drawing menu
The Affordable Answer - e = Specific-area zooming
fo Desktop Publishing/ ; ', i T = Multiple-line text
v, Produce Professional Quality o || % el i patterns
A Materials with Your ST! : : 2} = Edit polyline
oy bt = Flip/mirror objects
instantly ‘
= Rubberband drawing

o wrE e mode ,
~ Newsletters, etc., go together quickly Use one of two windows to draw your = Single GEM file format

~ since you can place text and graphics objects. When moving objects between ® Metric/Inch page size
~_onapage in any format. No more ~ windows, Easy-Draw automatically and measurements
~_messy paste-ups. copies them for you. = Multiple drawing

windows
Desk File Page Edit Arrange Text Line Pattern Color 9 ange Text Line Pattern Color
el R gehE s = = T UHDE K SEH T
\ Full Page | 3 SALES BY QUARTER: M/GHA PH
, \ | Last - e T

oo PRODUC T—
 INFORMA

Easy-Draw lets you zoomin on a spe- It's easy to be creative using the flip/
cific area of your drawing, and then mirgor feature. The patternsand
continue to zoom in, to get the fine ~ designs you can create are endless.

_ detail you want.

, 9
60:0: . "&lw-DrawSyslem

SMIGRAPH, | i

‘ ; AtariST with GEM/ TOSinROM
720 S 333rd St., Suite 201 + Federal Way, WA 98003 (206) 838‘4677 , or IMb memory. Monochmme or

color monitor.

Printers: Epson FX80 graphics
compatibles, Atari SMM804and
Gemini 10X. Drivers available
separately: Laser printers, plotters

Electric Software Limited, Umt 8, Cromwell Business Centre, New Road, St lves, Cambs PE17 4BG. ang’additional dotmatrix
. Tel: (0480) 66433. Telex 811 13 PM PROF G. Telefax: (0954) 80318. . printers.
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